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Chapter 1: Introduction
This User Guide explains how to use the FLOW Story client software supplied with EditShare FLOW
server systems. The User Guide is designed for any user of the FLOW system.

The User Guide assumes that the EditShare FLOW system has been installed and fully configured.
Administrators should refer to Appendix A: Administrator’s Guide for information regarding the
deployment of the EditShare Gateway on corporate networks. Additional information can also be
found in the FLOW Administrator’s Guide.

Overview
FLOW Story is an intuitive and powerful content creation tool that is tightly integrated with the
FLOW suite of EditShare applications. FLOW Story can be used by production assistants with little
editing experience, as well as fully fledged editors to prepare media for broadcast quickly and easily.
Unlike traditional NLEs, FLOW Story provides remote and secure access to on-premise stored media
directly through any internet connection. Aimed at fast turnaround environments such as News and
Sports, FLOW Story gives journalists and production teams the ability to package content for
finishing, delivery or playout.

FLOW Story’s features include:

● Proxy workflow for real time remote editing.

● Make full edits using FLOW proxies even when working remotely over slow broadband
connections.

● Real time collaboration with other FLOW users.

● Share your work with other FLOW users with whichever FLOW application they are using.
(Some advanced features created in FLOW Story may show as simple cuts in AirFLOW and
FLOW Browse).

● Voice Over recording direct to timeline.

● Add voice-overs to completed media prior to playout.

● Wide format support up to 4K (Hi-Res and proxy).

● Round trip support for Avid Media Composer and Adobe Premiere sequences.

● Support for multiple FLOW Database connections.

● Review and Approve workflow.

● Advanced real time effects, including Color, Titles and DVEs.

● Local Projects for full standalone operation.

Full screen playback of clips and sequences.
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Real Time Collaboration with FLOW Users
When connected to any EditShare FLOW Database, FLOW Story has real time collaboration with
FLOW clients running Story or AirFLOW.

Projects
Creating a project in the FLOW project space on one system allows other users with the privilege to
see and access the same project.

Clips
Clips that are imported into the project that exist in the shared storage spaces will also be available
to users in AirFLOW and FLOW Browse. Media that is imported from a local location will only be
available to other users on the server once the completed sequence is published and local media is
uploaded.

Sequences
Creating a sequence within FLOW Story means it is read/write to the creator and will be shown as
such with a green open padlock icon. This sequence will be marked as read-only to other users that
access this project, indicated by a red closed padlock.

Sequences can be shared with other users by clicking the padlock icon, access is relinquished and
set to ’no owner’ allowing any other user to take ownership by clicking the yellow closed padlock
icon to take ownership and have read/write access.

Markers
It is essential that Markers added to clips or sequences within FLOW Story are available to other
users that want to view and share progress in AirFLOW or FLOW Story.

Adding a Marker within FLOW Story will immediately update all other FLOW clients to show the text
and color of the added Marker to make viewing and approving a very fast process. Any changes to
the Marker within AirFLOW or FLOW Story will immediately be updated in FLOW Story.

Metadata
Similar to Markers, the same sharing happens with metadata added or removed to clips in the
FLOW database. All metadata changes from within a FLOW client are all updated and synchronized
in real time for other users to see.

Review, Approve, and Finish
Once a sequence is finished it can be viewed by another FLOW Story client on the local network or
from a remote location. Notes and Markers can be added to sequences allowing for the remote
editor to make changes whilst still in the field.
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When cutting a sequence remotely with proxy files - and the Hi-Res media is not available - the
sequence can still be flattened out to a media file using the proxies. However, another user running
FLOW Story on the local network (who does have access to the Hi-Res material) can access the same
project, take ownership of the sequence and begin the flattened file export using the Hi-Res media
that is available.

Round Trip Support for NLE Sequences
FLOW Story supports industry-standard NLEs (and DAWs) such as Avid Media Composer®, Adobe
Premiere®, Blackmagic Design DaVinci Resolve®, Avid ProTools® and Final Cut Pro X®.

Publishing the sequence metadata from a sequence made of proxy or Hi-Res media back to the
FLOW Server assigns an AAF or XML to the sequence in the background. This AAF contains advanced
cuts, simple dissolves/crossfades, audio levels and Markers all linking automatically to the Hi-Res
media.

FLOW shows a simple cuts-only representation of the sequence, but when the sequence is dragged
and dropped into the chosen craft editor, the AAF or XML is used instead of the FLOW sequence -
allowing for more advanced sharing between FLOW Story and the craft editor.

Offline Working
While you only need a regular Internet connection to access your content, that is not always
possible. FLOW Story can work in an offline mode, using the cached local copy of the project.

Before going offline, Hi-Res or Proxy media can be selected for download to the local system from a
bin, sequence or individual clips.

Once reconnected to the Internet, any new changes from both the local system or server project are
synced together, ensuring your team can see the latest updates.
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System Requirements
In order to run FLOW Story, the following requirements must be met:

Server
● FLOW Admin server

● FLOW EditShare Gateway server

Client Workstations
Windows

● One of the following operating systems:  Windows 10

● A graphics card that supports DirectX

● A high definition (HD) monitor with a minimum resolution of 1920 x 1080 pixels.

● Gigabit Ethernet (performance improves with faster workstations)

macOS

Note: Certain macOS  systems running Windows with Boot Camp - particularly those with ATI
Graphics chips - may not operate with FLOW correctly due to issues with OpenGL support in the
Apple drivers.

● One of the following operating systems:

○ macOS 10.16 (Big Sur)

○ macOS 10.15 (Catalina)

○ macOS 10.14 (Mojave)

● Intel-based models only.

● A graphics chip or card that supports OpenGL.

● A high definition (HD) monitor with a minimum resolution of 1920 x 1080 pixels.

● Gigabit Ethernet (performance improves with faster workstations).

Licensing

Administrators should make sure that each user has an account in FLOW Control to use the Browse
and Edit functions of FLOW Story.
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Technical Support
For questions not addressed in our documentation, contact EditShare Technical Support. Have the
exact version number of your FLOW implementation ready.

EditShare strongly recommends that you purchase a support agreement. If you do not have a
support agreement, a per-incident rate may be available.

Please contact EditShare Technical Support at the following URL:

http://www.editshare.com/support
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Chapter 2: Getting Started
Note: The keyboard shortcuts described in this manual are the defaults for FLOW Story. You can change
the keyboard shortcuts to suit your preferences, see "Keyboard Shortcuts".

Signing Into FLOW Story
1. Double-click on the FLOW Story desktop icon.

2. You are presented with the login screen.

3. Type your username into the username field.

Note: the account must have been created in FLOW Control with Edit or Browse privileges.

4. Type your password into the password field.

5. Click Sign in.
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Project Browser
The Project Browser View is the first screen you see when you load FLOW Story. Projects are used to
organize media which you can then publish or share with other users to edit before publishing. If
projects have already been created in other FLOW clients or by other users they display as tiles in
the Project Browser.
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Projects View
The Projects view is the first view you see when you open a Project in FLOW Story.

1. Browse Tab 2. Function Tabs 3. Project Content 4. Local Files Area

5. Clip Viewer 6. Scrub Bar 7. List of Markers 8. Hints Popup
Panel

9. Metadata Panel 10. Clip Thumbnail 11. Project Card
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Edit/Sequence View
Click the Edit tab (1) or press F2 to access the Edit/ Sequence View.

1. Edit Tab (accesses
Sequence View)

2. Project Contents 3. Clip Viewer 4. Sequence
Ownership/Locking

5. Marker IN/OUT/Clear
Buttons

6. Undo/Redo Buttons 7. Add Voice Over
Button

8. Sequence Timeline

9. Timeline Scrub Bar 10. Clip in Sequence 11. Video (V) and
Audio (A) Tracks

12. Timeline Zoom
In/Zoom Out
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Video Effects (VFX) View
Click the VFX tab (1) or press F3 to access the Video Effects (VFX) View.

1. VFX Tab 2. Setting Tab 3. Clip Viewer 4. VFX Timeline

5. Effects Track
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Audio View
Click the Audio tab (1) or press F4 to access the Audio View.

1. Audio Tab
(Accesses Audio
View)

2. Add Audio Effect 3. Clip Viewer 4. Audio Mixer

5. Audio Channel
Balance Control

6. Audio Channel
Level Indicator

7. Audio Channel
Indicator

8. Timeline

9. Track Labels 10. Effect Settings
Panel

11. Audio Effect Selector
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Changing the Desktop
Note: See "Appearance" to change other aspects of the desktop.

Resizing Panels
You can resize most panels in FLOW Story if you want a larger viewing area for media items.

1. Hover your mouse over two adjoining vertical or horizontal panels until the cursor changes
to a double-ended arrow.

2. Hold down the mouse key and drag to resize the panel.

3. Release the mouse button.
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Show / Hide Hints
To help you learn the basics, information about functions you initiate display as hints.

1. To clear a hint, click the OK button.

2. To stop these messages displaying, click on ‘Show hints’ to turn off the green indicator.

3. If you have disabled hints, you can restore them as follows:

a. Click the button at the top left corner of the screen to return to the Project Browser.

b. Click on the Cogs icon at the top right corner of the Project Browser.

c. From the menu that opens, click ‘Show hints’ to alternately hide or show hints.
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Hovering
When you hover your mouse over some screen objects, a hint displays, revealing further
information about that object.

1. To enable or disable hints, do one of the following:

a. Click on the Cogs icon in the top right corner of the Project Browser.

b. Right-click inside the Project Browser.

2. From the menu that opens, tick or untick the hints menu option to enable or disable tooltips.

3. If hints are enabled, you can change the speed at which they display. Repeat step 1 and,
from the menu that opens, select Fast, Slow or Never.
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Projects
Projects are used to organize media that you create or capture on your FLOW system. FLOW Story
displays all the projects on the FLOW Server that were created with AirFLOW or FLOW Story. Any
application that can create a FLOW project can be accessed by any FLOW user who has the
appropriate permission.

FLOW projects help you organize your media, allowing you to group clips into separate projects,
which you can then choose to share with other users if you wish. Projects created in FLOW Story are
exactly the same as those created by other applications, and occupy the same storage spaces as
FLOW. When you start FLOW Story, you are presented with a series of graphical tiles arranged into a
grid. Each tile represents a project in FLOW. You open a project by double-clicking on it.

Working in Offline Mode
You can use FLOW Story in offline mode and re-sync your projects and files with the FLOW server
the next time you connect.

If the server is unavailable, the following message displays.

1. Click the Yes button to continue working in offline mode. Files in FLOW storage spaces will
not be available to you, but sequences and clip logs will, as well as local media previously
downloaded in FLOW Story.

2. Click No to close the message.
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Creating a New Project
FLOW projects help you organize your media, you can group clips into individual projects which you
can then share with other users. When you start FLOW Story, you are presented with a series of
graphical tiles arranged into a grid. Each tile represents a project in FLOW.

1. In the Project Browser, click on the “Create a new project” link.

2. When the New project details dialog box opens.
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a. Enter a name for your project in the Name text box.

b. Choose who the project can be viewed by from the drop down list.

c. Choose who the project can be modified from the drop down list.

d. You can also type any relevant notes.

e. Click Create. A new, empty project is created and opens with the Browse tab selected.

3. You can now add clips to your project as required.

Importing Media
Importing Clips into a Project
You can import clips from your local folders and network drives. The clips you import should have a
frame rate that is compatible with your project. (Clips with incompatible frame rates may be
playable in a new project set to the same frame rate as that clip).

1. Select the Browse tab.

2. Click Local Files under the Libraries heading.

3. Click on the Places drop down list and navigate to the drive and folder you require.
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4. Click on a file to select it for import to your project, or hold down the Shift or Ctrl key (Cmd
key on Mac OS X) to select multiple files.

5. Select the import method from the drop down list. Select one of the following options:

○ Copy Local. Copies the files to your machine. If you have created a link to files that are
on an external drive and it is offline, you will not be able to use these files. Using the
copy local option means that your files are always available, it also means that you must
know exactly where your files are, which is useful if you are using multiple drives.

○ Upload location. Creates a link to the location of the files that you want to import and
uploads the files to this location. These files could be on an external drive; creating a link
to these files means there is only one copy of the files, making them easier to maintain
and update.

○ Transcode. Converts the file into the chosen file type and compression option.

Note: When you select the import method you also have the option of uploading the clip to your
storage space at the same time. This is dependent on the storage space being mounted, and a
suitable connection to the Internet being available. Moving your clip at the same time as
importing it saves time because the clip is immediately available on the storage space.

6. To upload the clip to your storage space at the same time, click the Upload location drop
down list and select the storage space that you want to use.

7. Click the Import button.

8. When the clips have been imported, the Content Manager switches to the Bin or Filter
containing the clips you have imported.
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Importing Clips from Storage Spaces
Storage spaces are used to store media created in FLOW. You can import clips from the storage
spaces that your account has access to.

1. Select the Browse tab.

2. If there are more storage spaces that can be displayed on the screen at once, use the scroll
bar to scroll upwards and downwards through the storage spaces and double click the
storage space to load it.

a. Enter the name of a clip, subclip, or document that you want to locate within the storage
space.

b. Click Search to find the media within the storage space.

3. You can import a clip using one of the following methods:

a. Click on the clip you want to import.

b. Click the Import button.

c. Double-click on the clip you want to import.

d. To select multiple clips, hold down the Shift or Ctrl key (Cmd key on Mac OS X), left-click
on the clips you want, and then click Import.
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4. Imported files display in the Recent filter of the Content Manager.

Scanning Storage Spaces

You can scan storage spaces in FLOW Story to update the FLOW database with information about
media that is not currently captured by FLOW. You can scan storage spaces in FLOW Control, or if
you have not done this you must scan storage spaces in FLOW Story.

1. Browse to the storage space that you want to scan.

2. Right-click on the storage space and select Scan from the menu.

3. You can choose to scan the storage space using one of the following three methods:
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● Quick - New and modified files are scanned and added to the database. Use this option
if you only have a few new files to add to the databases because it takes the least
amount of time to complete.

● Normal - New and modified files, including their metadata, are updated in the database.

● Full - All files and metadata are checked, with all changes written to the database.
Changes to template profiles are included. This option should be used after system
updates or when templates have changed. A Full Scan takes the longest time to
complete. When you select to do a Full Scan, a message displays, warning that metadata
extraction rules will be re-applied to all media, overwriting any changes you have made
since the last Full Scan.

4. The selected Storage Spaces are scanned and you can now select the media that you want to
import.

Storage Spaces Status

The type and status of storage spaces is displayed in the Storage panel.

1. Access Level is determined by the outline colour:
a. White - File level access
b. Grey - Metadata level access (see FLOW Admin guide: Storage chapter for detail)
c. Red - Deleted storage space

2. State is determined by the LED icons:
a. Yellow - Archive storage
b. Green - Online to FLOW system
c. Orange - Mounted to local host
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FLOW Transfer Service Partial File Copy
Typically, archived media files can be very large and rather than retrieve the media file, it is more
desirable to retrieve only the required parts of the files, either to save space on local storage or to
reduce transfer times when the archive is held remotely. Whether this capability is available
depends on the codec, wrapper, and storage types.

Partial file copy is accessed using the FLOW Story Restore Region function. This in turn calls the
Transfer service API.

Note: Due to the different methods that are required for different storage types, only mountable storage
types are supported (including Azure and S3). The storage types that are currently supported for a given
release can be found using the storage capabilities api call
https://flow_server_ip_address:8006/api/v2/transfer/storage/capabilities?html=true

Partial Copy Implementation
Mountable Spaces

For mountable spaces, after validating the request, the transfer service submits an API request to
the ingest server to transcode the requested part of the clip, if possible as a rewrap operation.

The ingest server is responsible for adding the new clip to FLOW, establishing the relationship with
the parent and adding the clip to the specified project. Ingest sends notifications for asset added
and project entry added, and on completion the Transfer service also sends a partial copy:complete
notification.

Ark

Partial copy from Ark is only supported using FLOW Browse.

Flashnet

MassTech has their own partial file restoration implementation and this has been integrated with
Flow Transfer as an automation workflow. It has different capabilities in terms of supported file
types relative to the new FLOW implementation.

Closing a Project
To close a project, and return to the Project Browser, click the Exit button at the top left of the
Project window.
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Deleting a Project
Deleting projects does not delete any media on the FLOW server. If you have imported files from the
Local files tab and you delete a project, that media is deleted only if it was imported as ‘Transcode’
or ‘Copy Local’. If media was imported using ‘Create Link’, only the link is deleted, not the file.

Deleting a project while online deletes the project on the server and removes all access from other
FLOW clients.

There is no ability in FLOW Story to copy files between projects.To delete a project:

1. In the Project Browser, click on the Cogs icon for the project you want to delete.

2. From the menu that opens, click Delete.

3. A message box opens, warning you that your project is about to be deleted and that you
may lose data.

4. Click Yes, delete project to confirm the deletion, or No, Cancel to cancel the operation.
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Project Contents
Project Contents section is where you organize and manage your Clips, Sequences, Bins, and Searches.

You can create Bins and add media to them and filter results by selecting the appropriate filter. You
can also add your own filters by clicking the + icon next to Filters in the content manager.

1. Select the clip you want from under the Filter or Bins under Project Contents. The results
display in the main window. You can also search for a file using the search icon.

2. Add a new bin by clicking the plus (+) sign next to the bins heading

3. Add a clip to the bin by clicking and dragging into the appropriate bin.

4. Toggle between Tile and List views by clicking the View button. The Content Manager has
two main display modes:

● Tile View. Clips and Sequences display as thumbnails.

● List View. Clips and Sequences display in a list format with relevant metadata as well as
thumbnails.
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Using the Media Types Filter
The Content Manager uses a set of filters that allows you to organize your media by type, creation
date, search criteria, and so on. You can also review your searches through the Project Contents
Search Filter.

To use the Media Types filters:

1. In the Project Contents Filters panel, click on one of the following media types:

● Clips

● Subclips

● Sequences

● Everything

● Recent

2. The bin or filter displays the type of media you selected.

3. If you selected Recent, the media displays in chronological order.

4. To change the view of displayed items, click the heading that describes the type of files you
want to view. You can choose from the following options:

● All - displays all files.
● Video Only - displays files that only contain video.
● Audio Only - displays files that only contain audio.
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Creating a New Bin
Bins are used to organize and display your clips and sequences. You can move and copy clips to
other bins, and change the way bins display clips.

It is possible for a clip to be in more than one bin at the same time. You can use this feature to help
organize your material. However, seeing a clip in more than one place on the screen does not mean
there is more than one copy of the clip on the hard disk.

1. Click the plus sign (+) next to the Bin heading.

2. The new bin displays below the Bins Heading.

3. You can change the name of the bin by selecting the text and typing the desired name.

For further information about Bins, refer to"Chapter 8: Bins and Groups".
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Chapter 3: Clips
A clip is created by a single continuous recording of picture and / or sound onto the Flow server. A
clip is stored as both a log file and a material file. The log file for a clip contains logging information
such as the clip name, tape ID and timecode. The material file contains pictures or sound for the
clip.

You can move through your material in several additional ways. You can jump to a specific
timecode, and you can insert Markers and then jump to them.

Recordings may need further preparation - for example, breaking down into subclips or shorter
sections of a longer clip. The products of these processes are called Subclips (see "Working with
Subclips").

Playing in Tile or List View
When you import a file, it displays by default in one of these locations:

● The ‘Recent’ tab of the Content Manager (default).

● The ‘Search’ tab of the Content Manager (user option).

● A bin of your choosing.

To play a clip, whether it is in Tile or List View:

1. Click anywhere in the picture area of the clip.

2. The border changes to bright blue.
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3. Use the playback keyboard shortcuts. The default shortcuts are as follows:

● Play/ Stop - Spacebar

● Play (Backwards) - j

● Stop- k

● Play (Forwards) - l (Lower case ‘L’)

● Shift+Play - Holding down the Shift key while pressing the Play icon or shortcut key plays
the media in reverse.

4. Hover your mouse over the tile or list item to reveal the scrub bar, then click on the red
timeline marker to drag it backwards or forwards through the scrub bar.

Playing in a Viewer
You can play clips in the Source Viewer on the right hand of the display. You can also watch clips in
Full Screen mode.

Opening a Clip in a Viewer

1. Select the Browse tab.

2. Load a clip into the viewer using one of the following methods:

3. Double-click on the tile or list item.
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4. Drag the tile or list item onto the viewer.

5. The selected clip opens in the source viewer, with the name of the clip at the top of the
viewer.

6. The right and left ends of the scrub bar represent the start and end of the clip.

7. To open another clip in the same viewer, repeat step 2.

Playback in a Viewer

1. Open a clip in the viewer.

Default Shortcuts:

● J - Reverse Play

● K - Pause

● l - Play

2. Play the material by doing one of the following:

● Use the keyboard shortcuts for playback.

● The playback controls on the viewer.

3. To move through the material, click the red frame marker in the Indicator strip and drag it
where you want.
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4. To jump to a new point, click in the Indicator strip at the timecode position you want to jump
to.

Displaying Full Screen Video

1. Do one of the following:

a. Press the Toggle Full Screen shortcut key.

b. Double-click on the image in the viewer.

Default Shortcuts:

● F12 - Toggle Full Screen

2. The media displays in full size on the monitor, complete with playback / marker controls and
scrub bar.

3. Move your mouse onto the full screen image to reveal the playback and marker controls,
and scrub bar.

4. Use the playback and marker controls to move through the clip and to add marks.

5. Use the scrub bar to move backwards and forwards through the clip.
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6. To close full screen mode, press the Toggle Full Screen shortcut key again or double click the
clip.

7. You can also close the full screen mode by moving your mouse onto the extended display
and clicking the Exit Full Screen button.

Switching to Another Clip in Full Screen Mode

1. Open a clip in full screen mode.

2. Move your mouse to the top of the screen until you see thumbnail clips.

3. Click on the clip you want to load.

4. The selected clip displays in full screen mode.
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Managing Clips
Finding Information about Clips

1. Select the Browse tab.

2. Do one of the following:

● Double-click the clip you want to review.

● Drag and drop the clip you want onto the viewer.

3. The clip loads into the viewer.

4. There are four areas that you can use to get information about clips:

● Metadata - Information about the clip. The information that displays depends on the
media type and templates that are enabled in Flow. Some metadata fields are non
editable. These are fields that contain information such as the frame rate, creation date,
modified date, and start time. These fields are not editable because the timecode was
set when the file was captured. Other fields such as Scene, Take, and Comments can be
edited by typing directly into the corresponding fields.

● Markers - You can view any markers that have been made on the clip. These could have
been added by yourself or another user and are typically used to mark points of interest
within a clip. You can enter single markers, or range markers that cover a section of a
clip.
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● QC - You can view the quality of the files on your system in the QC tab. You must have
QScan installed on your server to view QC information. Ask your administrator if you are
unsure. QScan is an application that analyzes the audio and video signals in your files.
The results describe how the files meet the criteria you have specified, marking areas in
the clips that correspond to any issues found.

● Timeline - Displays the current clip as frames in the timeline. You can use the timeline
view for viewing the audio waveform of a clip, changing the volume of a clip and
selecting/deselecting which tracks are enabled/disabled.

Renaming Clips
Renaming a clip only changes the name of the clip in the FLOW database; the file name of the
source file does not change.

To rename a clip:

1. Follow steps 1 and 2 of "Finding Information about Clips".

2. Type the new name for the clip directly into the Name text box.

Deleting Clips
To delete a clip:

1. In the Content Manager, right-click on the clip you want to remove and, from the menu that
opens, select Remove/delete selected items.

2. A dialog displays asking you to select which items you want to delete.
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3. The option to remove clips from the project does not delete any media, just the clips that are
in the project.

4. Items that are grayed out are not available for that clip.

5. Click the check box that corresponds to what you want to delete.

6. Click the Remove button.

Selecting Timecode Labels
The current timecode for selected clips display at the bottom of the source or sequence viewer. You
can change the format of the displayed timecode format through the Labels menu.

To change the timecode label a viewer displays:

1. Click the arrow to the right of the viewer timecode.

2. The Labels dialog box opens.

3. Select the timecode format you require. The options are:

● Primary T/C - Source timecode for the current frame (in blue).

● Marked Duration - Duration between the mark and the current frame (shown in purple),
or the duration between the start and the current frame if no mark exists.

● Total Duration - Total length of the clip in the viewer (shown in red).
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Alternatively, you can hover your mouse over the timecode label, using the mouse wheel to
change the label.

4. The selected timecode format displays below the viewer.

Jumping to a Timecode
Direct Timecode Entry
You can enter a direct timecode into a source or edit viewer. To do so, click the Timecode text box in
the label, type the timecode you want, starting from the left-most position, and press Enter. The
viewer is cued at the timecode you entered in step 1.

Timecode Tear-off
You can create a Tear-off timecode as follows:

1. Load a clip or edit into the viewer, and stop at the timecode you want to tear-off.

51



2. Click the arrow next to the timecode that is indicated with blue text.

3. Hold down the left mouse button and drag the timecode label off the viewer. You can create
as many tear-off labels as you want for a given clip or sequence. Tear-off labels do not have
to contain different timecodes.

4. To cue a viewer go to a specific timecode:

a. Make sure the source or edit viewer you want to cue is open.

b. Click and drag the selected timecode over the timecode label.

c. When the triangle on the tear-off’s bottom-left corner changes from yellow to green,
release the left mouse button.

d. The viewer is cued at the timecode of the selected tear-off.

5. To cue any tile to go to a specific timecode:

a. Make sure the tile you want cued is displayed in the Content Manager.

b. Click and drag the selected timecode over the tile you want to cue.

c. When the triangle on the tear-off’s bottom-left corner changes from yellow to green,
release the left mouse button.

d. The tile is cued at the timecode of the selected tear-off.

6. To remove an unused tear-off from the desktop, click the X button.
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Markers
You can use markers to identify points of interest in your material or collaborate to review
clips/sequences. You can use markers for reference points, moving through material by jumping to
them. Markers display as small triangles on the viewer timeline strip. You can enter single markers,
or ranged markers that cover a section of a clip.

Markers added in FLOW Story also display on the same clip in other story clients and AirFLOW.
Likewise, if the markers are changed in AirFLOW the changes also display in FLOW Story.

Adding a Marker
To add a marker, complete the following:

1. Move the timeline marker to the position in the clip you want.

Default Shortcut - ‘ (apostrophe) = Marker

2. To enter a single marker, click on the marker button below the viewer, or press the marker
shortcut key. The marker displays on the timeline.

3. The marker dialog box opens:

a. Optional: Type a name for your marker in the Name field.
b. Optional: Add any additional information about the marker in the Description field.
c. Optional: Click on a color to set the color for your marker. The default color is green.

4. To enter a marker on a section of a file, a ranged marker, mark the In and out points, click
within the section you have just marked and then click the add marker button.

5. To view information for all of the markers that you have added to a clip, click the markers
tab under the viewer. A list of all the markers that are associated with the clip are listed
sequentially, with their Timecode, Name, and Description. You can edit the Name and
Description fields, but not the Timecode because this was fixed when the clip was created.
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Jumping to Markers
Jump to a Marker in the viewer by completing the following:

1. Click the Markers heading under the viewer.

2. Click the Marker in the Markers Panel.

3. Click on the Marker in the Timecode scrub bar.

Editing Markers
There are two ways to edit a Marker; by using the markers panel, or selecting the marker in the
timecode scrub bar.

1. To edit the marker using the markers panel, click the marker that you want to edit in the
markers panel, and edit the property that you want to change.

a. Click on a color in the color palette to select it.

b. Rename a Marker by clicking on it and typing the new name.

c. Click in the description field and type a description.
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d. Press Enter to save your changes.

2. To edit the marker in the timecode scrub bar, click the marker in the timecode scrub bar,
and edit the popup window.

a. Click on a color in the color palette to select it.

b. Rename a Marker by selecting the existing text and typing the new name.

c. Click in the description field and type a description.

d. Press Enter to save your changes.

55



Deleting Markers
To delete a Marker:

1. You can delete a marker in two of the following ways. Using the first method:

a. Click the marker that you want to delete on the scrub bar.

b. Click Delete in the Marker dialog box that opens.

2. Using the second method:

a. Select the marker in the list.

b. Click the Delete button below the viewer.
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Exporting Markers
You can export Markers to a Comma Separated Values (CSV) file as follows:

1. Right-click inside the Marker Panel and, from the menu that opens, select Export to text file.

2. The Export panel opens asking you where to save the file.

3. Click Places to open the drop down list of folder locations to save your file.

4. Type a name for your export file in the text box.

5. Optional: Click the Create new folder button to add a folder at the export location that you
have specified.

6. Click OK.

7. A message box opens, confirming the location where your export file was saved.
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Publishing Clips from FLOW Story to Avid - Markers
On the initial publishing of a clip to Avid, all markers and range-markers (or the absence of any
markers) are accepted by Avid and the Avid clip is updated.

NOTE: It is important that the initial publishing of the clip markers be correct, as on any subsequent
publishing of that clip, Avid will ​not​ update the state of the markers on that clip, even if it is published to a
new/different Avid project.

Also, if there are two or more FS clips, which are a part of the same “spanned” MXFclip, with each
having their own markers, and you publish them to Avid (that is, either individually or they have
been cut into a sequence), only one of the clips will transfer its markers to Avid. This is a result of
the initial publishing of the clip to Avid.

Enabling Live Logging from Within the Markers
Panel
Live logging is a mode that is different from adding markers normally. When enabled, live logging allows
users to enter marker metadata information, which is then immediately added to the new marker.

Custom marker metadata can be used with Live logging, refer to the Metadata chapter of the FLOW
Control Administration Guide for additional information about creating metadata templates.

Live logging can be enabled from within the Markers Panel, as follows:

1. Open the markers panel for a clip (or sequence).
2. Click on the Live logging check-box. For example:

Note: There are now two marker views available.
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3. Once enabled, markers can be added during playback by clicking “-”, as the first key-press
triggers the addition of a new marker. The text entered is added to the marker's description.
Pressing Enter completes that marker. This can be repeated to add successive markers.

When the custom metadata is loaded, you can select each entry without stopping the
playback, meaning you can start playback and then click on the player's photo to log that
person, without the playback being interrupted.

Creating a Sequence using Ranged Marker Metadata
After long takes have been marked up for sections using ranged markers with metadata you can
create a sequence very quickly from these ranged markers by searching for particular criteria in the
search box or selecting multiple ranged markers, then creating a sequence based on the metadata.
A good example would be ranged markers that have 'Goal' as one of their metadata fields to
highlight all the goals scored during the loaded clip:

1. Open Story to the Browse tab.

2. Select the markers panel.
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3. Enter search criteria into the search box provided on the markers panel or highlight the
marker entries manually.

4. Markers that meet the search criteria in the shot will be selected (highlighted).

5. Right click the markers panel and select "Make -> Sequence".

6. A sequence will be created based on the metadata from the markers and placed into a
newly created sequence.

60



Triggering Automation Tasks from Markers
If an Automation task has been created for Markers then it can be triggered from the Markers
panel. Instructions for creating an Automation task can be found in the Automation Guide:

1. Open Story to the Browse tab.
2. Select the markers panel.
3. Enter search criteria into the search box provided on the markers panel or highlight the

marker entries manually.
4. Markers that meet the search criteria in the shot will be selected (highlighted).
5. Right click the markers panel and select Automation-> AUTOMATION TASK NAME (An

Automation task will need to have been created in order for it to appear here).

The Automation task will start and appear on the Tasks panel of the project card.
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Chapter 4: Basic Editing
Marking a Section on a Clip
You can define shorter sections of clips by creating marks in the timeline of the source clip. This
technique is used mainly for creating subclips, inserting sections into Sequences and marking areas
for audio-visual effects.

Making a Subclip (Mark and Park)
The easiest way to mark a section from a longer clip is to use the Mark and Park function. You do
this by marking the In point and using the current frame as the Out point.

1. Load your clip into the clip viewer.

Default Shortcuts: i = Mark/Mark In, o = Mark out

2. Stop the media at the position in the timeline where you want the In Point.

3. Click the In Point button. Alternatively, press the assigned shortcut key.

4. Move the current frame to where you want the section to end.
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5. The section between the mark and the current frame is now selected.

6. To create a subclip, press the Make Subclip button. The subclip displays in the Recent and
Subclips filter of the Content Manager.

Marking with In and Out Points
You can mark a clip with In and Out Points. Do the following:

1. Load your clip into the clip viewer.

2. Stop the media at the position in the timeline where you want the In Point.

3. Click the In Point button. Alternatively, press the assigned shortcut key.

Default Shortcuts: i = Mark/Mark In, o = Mark out

4. Move the current frame to where you want the section to end.

5. The section between the mark and the current frame is now selected.

6. Press the Mark Out button on the viewer. Alternatively, press the assigned shortcut key.

7. To create a subclip, press the Make Subclip button. The subclip displays in the Recent and
Subclips filter of the Content Manager.
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Marking the Entire Clip
You can select the entire clip by, pressing the shortcut key for selecting the entire clip. The default
shortcut key to select the entire clip is ].  When selected, the entire clip is selected.

Swapping In and Out Points
If you mark an In point and then want to jump to a different In point, you lose your Out mark. To
swap In and Out points without losing the Out point:

1. Mark a section in the clip timeline using the Mark and Park procedure (see "Making a Subclip
(Mark and Park)").

2. Complete one of the following:

● Press the shortcut key assigned for Swap ([ = swap).

● Hover your mouse over the In Point, then click and drag the In Point to the required
position.

3. The blue marker ‘A’ replaces the red current frame marker, and the red current frame
marker ‘B’ replaces the blue marker.

Note: Although you have swapped the points around, the first marker is still the In point, that is, if
you mark and park then press the Swap button, the In Point is now ‘park’, where previously it was
‘mark’.

4. You can now change the position of the In point using the playback controls.

Working with Subclips
A subclip is so named because it has no material of its own. When you play a subclip, it plays the
pictures and sound from the material files of its original clip(s).

Making Subclips
You can make a subclip from any clip that has been marked using one of the methods described in
"Marking a Section on a Clip". To make a subclip:

1. Load a clip into the source viewer.

2. Complete one of the following:

● Click on the Make Subclip button below the source viewer.
● Right-click inside the viewer and, from the menu that opens, select Make > Subclip.
● Create and use a keyboard shortcut for ‘Making a Subclip’.

The subclip is added to the Content Manager. Subclips are identified by a blue flag in the top
left corner of tiles, thumbnails, and viewers.
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Deleting Subclips
If a subclip is deleted, the original clip (log and material) is not deleted. Deleting a subclip is like
deleting an edit, since a subclip does not actually have material of its own.

If you delete the material for the original clip, any subclips that are referenced to them are also
deleted.

To delete a subclip:

1. Right-click on the subclip. The REMOVE/DELETE dialog is displayed:

2. Click Yes, Delete. The subclip is deleted.

Undoing and Redoing Subclips
Undo and Redo have no effect when applied to a subclip. A sequence made of subclips behaves in
the same way as a sequence made of clips.

Working with Sequences
Sequences are a series of clips and subclips arranged in the required playing order. They can be

identified by a red flag in the top corner (in Tile view) or in the Title bar of the Sequence viewer.

In their basic form, sequences are a list of edit points without pictures, sound, or timecode, which
refer to the logs of their constituent clips for labeling information such as timecode.

When you view the sequence, it plays the pictures and sound from the material files of the original
clips.

FLOW Story sequences can be much more advanced than those created by AirFLOW. Once FLOW
Story has modified a sequence beyond a simple cuts only sequence, AirFLOW will not be able to
display it until a sequence proxy is published.
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Opening an Existing Sequence
To open an existing sequence:

1. Select the Edit tab to reveal the Sequence view.

2. Click on Sequences under the Filters heading to display the available sequences in your
project.

3. Double-click on the Sequence you want to open.

4. The Sequence displays in the viewer.

5. The video and audio tracks for each clip and subclip in your sequence display in the timeline.

6. The name of the owner of the sequence displays at the top right hand corner.

Note: You can make empty sequences by right-clicking in the Sequence area and selecting Bin Commands
- Make - Empty sequence. You can then add clips to this sequence.
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Changing Ownership of Sequences
When you create a new sequence you have ownership of it. This means that you have Read / Write
access to it, and other users have only Read-Only access to it. Other users can open your sequence,
play it, or make a copy of it, but they cannot make changes to your sequence. After a user makes a
copy of a sequence, that user has Read/Write access to it. Any changes made to a sequence are
updated in the project.

A padlock icon displays in the top right corner of the sequence’s thumbnail, and in the title bar of
the Sequence viewer.

To change the ownership of a file:

1. As the creator or owner of an edit or sequence, click on the green (open) padlock icon in the
sequence viewer or thumbnail.

2. The padlock changes to an amber (open) padlock. Any user can now claim ownership of the
sequence.

3. You cannot assign ownership of a sequence to another user.

4. To claim ownership of a sequence, if the padlock icon is amber, click the icon. The icon
changes to a green unlocked padlock, confirming the sequence is now owned by you.

5. A sequence can be in one of the following ownership states, displayed by the color of the
padlock:

● Green padlock - sequence is owned by you.

● Amber - sequence has no owner.

● Red - sequence is locked by another user.
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Creating Sequences
Note: Audio tracks are grouped by default in new sequences created by FLOW Story.

Sequences are a series of clips arranged on the timeline in the required playing order. Sequences
are identified by a red flag in the top corner (in Tile view) or in the Title bar of the Sequence viewer.
When you view the sequence, pictures and sound are played from the material files of the original
clips.

1. Select the Edit tab to reveal the Sequence view. New projects always open with a blank
sequence.

2. Select the Clips or Subclips filter to display the available clips in your project.

3. Select the first clip you want in your sequence and drag it onto the timeline. The clip’s video
and audio display as separate tracks in the timeline.

4. Select the next clip you want in your sequence and drag it onto the timeline.

5. The video and audio tracks of the clip display in the timeline.

6. Repeat steps 2 to 6 to add further clips, as required.
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Using the Source Viewer
Sometimes when adding clips to a sequence, it is easier to view the source material inside a larger,
dedicated viewer. This can be useful when you need to add In and Out Points before adding to the
sequence.

1. Click the Edit tab to load the sequence you require into the viewer.

2. Select a filter or bin that contains the media you want.

3. Double-click on the source clip (in Tile or List view) that you want to add to your sequence.

4. The source material opens in the Source viewer.

5. Make the adjustments you require to the source, for example marking In and Out Points.

6. Drag and drop the source material into the required position in the sequence, or press the
insert or replace button in the source viewer.
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Removing Material from a Sequence
When a clip is removed from the sequence timeline, you have the option to leave an empty black
section where the clip used to reside, or move the remaining clips to fill the gap.

1. Click the Edit tab to load the sequence into the viewer.

2. Position the timeline marker at the start of the cut you want to remove. Use the shortcut
keys to jump left or right to the cut you want. Default Shortcuts include:

a = Previous Cut
i = Mark In
s = Next Cut

3. Click the Mark In button, or press the Mark In shortcut key.

4. A blue In point marker is placed on the scrub bar and a corresponding blue marker is
created on the timeline.

5. Position the timeline marker at the end of the cut you want to remove, or press the Next Cut
shortcut key.

6. Complete one of the following:

● Click the Remove button to replace the clip with black.

● Click the Delete button to delete the clip and move the remaining clips to fill the gap.
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7. The marked section is removed from the sequence.

Replacing Material in a Sequence
Open-Ended Replace from Tile

In an open ended replace, the In point is the first frame of the clip:

1. In the Sequence viewer, place the timeline marker where you want to insert your media (In
point).

Note: Do not press the Mark button. The current frame is the In point.

2. Select the clip tile you want to insert from the Project Contents window. Drag the mouse
over the tile’s timeline to select where you want the inserted material to start. Default
shortcut keys include:

b = Replace
p = Unmask

3. Make sure neither viewer has a blue mark in the timeline strip. If a blue mark is present, click
the Unmark button on the Sequence viewer, or the default Unmark shortcut key on the
Source view.

4. Press the Replace shortcut key.

5. Everything from the source In point on replaces everything from the Sequence In point on.
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Open-Ended Replace from Source Viewer

You can open source clips into a Source viewer before perform an open-ended replace:

1. In the Sequence viewer place the timeline marker where you want to insert your media (In
point).

Note: Do not press the Mark button. The current frame is the In point.

2. Double-click on the clip you want to insert from the Project Content window. Default
shortcut keys include:

b = Replace
p = Unmask

3. The clip opens in a larger Source viewer.

4. Drag the mouse over the clip’s timeline to select where you want the inserted material to
start.

5. Make sure neither viewer has a blue mark in the timeline strip. If a blue mark is present, click
the Unmark button on the Sequence viewer, or the default Unmark key on the Source
viewer.

6. Press the Replace shortcut key.

7. Everything from the source In point on replaces everything from the Sequence In point on.
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Source Selection Replace

Use this method if you want to edit in a specific cutaway with a known start and end point.

1. Position the timeline marker where you want to start the new material.

2. Click the Mark In button, or press the Mark In shortcut key. Default shortcut keys include:

b = Replace
i = Mark In
p = Unmask

3. Position the timeline marker where you want the new material to finish. There is no need to
click the Mark Out button as the timeline marker is the Out Point (Mark and Park).

4. Do one of the following:

● Select the clip tile you want to insert from the Project Contents window.

● Double-click on the clip you want to insert from the Project Content.

5. Drag the mouse over the clip or clip tile’s timeline to select where you want the inserted
material to start.

6. Press the Replace shortcut key.
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7. The new material is inserted into the Mark and Park section you marked earlier.

Backward Replace from Out Point in Source

If you know only the Out point for a replace in the source, you can use the Backward Replace
method.

1. Make sure the Sequence view does not have a blue mark in the timeline strip. If a blue mark
is present, click the Unmark button on the viewer, or press the Unmark shortcut key.

2. Position the timeline marker where you want the start of the new material in the timeline.

3. Click the Mark In button, or press the Mark In shortcut key.

4. Default shortcut keys include:

\ = Backtime
i = Mark In
o = Mark Out
p = Unmask

5. Position the timeline marker where you want the new material to finish. There is no need to
click the Mark Out button as the timeline marker is the Out Point (Mark and Park).

6. Select the clip you want to insert from the Project Contents window. Drag the mouse over
the clip’s timeline to select where you want the inserted material to finish.

7. Press the Backtime shortcut key. The selected section in the timeline is replaced by material
from the source and is trimmed to the same duration. The start point of the source material
is calculated backwards from the source viewer end (Out) point.
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Backward Replace from Out Point in Sequence

If you know only the Out point for a Replace in the Sequence timeline, you can use the Backward
Replace method.

1. Select the clip you want to insert from the Project Contents window and mark the section
you want using the Mark and Park method:

a. Drag the mouse over the clip’s timeline to select where you want the inserted material to
finish, and press the Mark Out shortcut key.

b. Press the Reverse Playback shortcut key and stop at the required In Point by pressing
the Pause shortcut key.

2. Make sure the Sequence view does not have a blue mark in the timeline strip. If a blue mark
is present, click the Unmark button on the viewer, or press the Unmark shortcut key.

3. Position the Sequence timeline marker where you want the inserted material to finish. This
is the Out point.

4. Press the Backtime shortcut key. The selected section in the timeline is replaced by material
from the source and is trimmed to the same duration. The start point of the source viewer
material is calculated backwards from the Sequence viewer end (Out) point.
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Deleting a Sequence
To delete a sequence:

1. If the Content Manager, right-click on the sequence you want to delete and, from the menu
that opens, click ‘Delete this sequence’.

2. A message box displays, asking you to confirm removal of your project.

3. Click on Yes to confirm the deletion, or click No to cancel it.

Saving a Frame from a Sequence
Frames are saved in the Portable Network Graphic (PNG) format. To save the current frame from a
sequence:

1. Pause the Sequence viewer at the frame you want.

2. Press the keystroke you assigned for ‘Save current frame’. The still frame is saved as a
Portable Network Graphic (PNG) file on your local drive and the file manager for your
workstation opens in the folder where your image was saved.

Publishing Sequences
FLOW Story allows you to publish to a desired medium (FLOW, Vimo, YouTube, and so on.).

Note: If BITC is enabled on the sequence, it will appear on published media from the sequence, including
sequence proxies.

Publishing a Sequence to a Desired Medium
To publish a sequence to a desired medium:

1. Complete one of the following:

a. Right-click on a sequence timeline and from the menu that opens, select Sequence
Commands > Publish > (Select the desired medium).

b. Right-click on a sequence in the Sequence viewer and from the menu that opens, select
Sequence Commands > Publish > (Select the desired medium).
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c. Select multiple sequences from the bin and then right-click, select Sequence
Commands> Publish> (Select the desired medium).

The Publish dialog box opens.

a. Select the Frame rate you require from the drop-down list.

b. Select the Size you require from the Size drop-down list.

c. Select the section of the sequence you want to publish from the Region drop-down list
(Marked section, Whole sequence, or Ignore leading/trailing black).

d. Login if the Authentication is set.

2. Click Publish. The progress of the Publish action displays in the Project Card’s Task window.
You can continue to work while the export process occurs in the background.
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Sequence Metadata
Metadata sequences are suitable for ‘round-tripping’, that is, transferring to third-party NLEs and
back again to FLOW Story. Publishing the sequence metadata from a sequence made of proxy or
Hi-Res media back to the FLOW Server assigns Advanced Authoring Format (AAF) or Hyper - Text
Markup Language (XML) features to the sequence. The sequence metadata contains advanced cuts,
simple dissolves/crossfades, audio levels and Markers all linking automatically to the Hi-Res media.
AirFLOW needs the sequence proxy in order to play back the sequence.

To publish sequence metadata:

1. Complete one of the following:

● Right-click on a sequence timeline and, from the menu that opens, select Timeline
Commands > Publish > Sequence metadata.

● Right-click on a sequence in the Sequence viewer. From the menu that opens, select
Publish > Sequence metadata.

● Select multiple sequences from the bin and then right click: Publish > Sequence
metadata.

2. The Publish dialog box opens.

3. Click the ‘Upload sequence proxy’ to upload the sequence metadata using proxy files, where
the Hi-Res media is not available. The sequence proxy is a flattened file that is rendered out
of Story of the sequence you are publishing. This is the only way a sequence is playable in
AirFLOW.

4. Click the ‘Upload local media files’ box to include clips that are on your local and must be
uploaded on the server for others to use and work with.

5. Click Publish. The progress of the Publish action displays in the Project Card task window.
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Saving or Copying a Sequence
Normally you do not have to save anything as every change or modification you make in FLOW Story
is saved automatically. If you want to save a Sequence, you can make a copy of it, and continue
working on the original.

1. Complete one of the following:

● Right-click in the timeline and, from the menu that opens, select Sequence Commands >
Make > Copy.

● Right-click on the viewer and, from the menu that opens, select Make > Copy.

2. If you marked a section of the timeline on your sequence, a message displays asking you if
you want to copy the entire Sequence or just the marked section:

● Click ‘All’ to make a copy of the entire sequence.

● Click ‘Marked section’ to copy only the section marked on the timeline.

A copy of the Sequence is created, with the text ‘(copy)’ or ‘(#Section x)’ appended to the same in the
title bar. The copy displays in the Content Manager as a separate Sequence.
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Chapter 5: Timeline Editing
This chapter covers the functions that can be performed using the timeline in the Edit tab.

Navigating the Timeline
Main Features
The main features of the timeline are:

1. The left end of a track represents the beginning of the clip or sequence and the right end
represents the end.

2. The Zoom In (+) and Zoom Out (-) buttons are used to zoom in and out on the timeline. The
Timeline ruler ‘A’ rescales according to the level of zoom selected.

Note: When the Timeline is completely zoomed out, or when it is close to the start or end of a
sequence, the current frame marker behaves in the normal way.

3. The Timeline marker indicates the position of the current frame on each track.

4. Do not click directly on cuts unless you want to unjoin the associated clips for trimming. See
"Trimming Cuts".
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Locking the Timeline Marker
You can lock the timeline marker in a fixed position. When the sequence is played, the timeline marker
stays fixed, rather like the heads on a synchronizer or flatbed editor, and the tracks scroll past it.

1. Press and hold the Alt key, and then click on the timeline marker.

2. Release the Alt key. The timeline marker locks in the current position.

3. The timeline marker changes color to purple.

4. When the sequence is played, the timeline marker stays fixed and the timecode ruler and
tracks scroll in the reverse direction.

Note: When the Timeline is completely zoomed out, or when it is close to the start or end of a
sequence, the current frame marker behaves in the normal way.

5. To unlock the timeline marker, press and hold the Alt key, and then click on the timeline marker.

6. The timeline marker color changes back to red. Release the Alt key.

Enabling Audio while Scrubbing
Note: This feature is not available when the timeline marker is locked.

To listen to audio while scrubbing through a sequence:

1. Hold down the SHIFT key, and then click on the timeline marker, keeping the mouse button
held down.

The timeline marker changes color to light blue.

2. With the mouse button held down, drag the timeline marker backwards and forwards
through the sequence. The audio tracks can be heard as you scrub through the sequence.

3. Release the mouse button to disable audio playback. The timeline marker color changes
back to red. Release the SHIFT button.
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Displaying Text on the Timeline
You can change the text shown in the timeline for each clip. You can choose from a list of various
clip metadata, including Name, Scene, Media Format, and so on. Not all metadata items display on
all tracks, for example:

● The Track source metadata (A1, A2, A3, etc.) only displays on audio tracks.

● The Media Format metadata only displays on video tracks.

● Metadata that requires input from users (Scene, Take, etc.) display blank if no values have
been entered.

You can display up to three metadata items from lists labeled Segment, Segment (2) and Segment (3).

1. Right-click in one of the Timeline tracks.

2. From the menu that opens, click on Sequence Commands > Settings.

3. The Timeline Settings dialog box opens.

4. Click on the Segment text drop down list.

5. From the list that opens, select the parameter you want to display in the timeline. If you do
not want to display anything, select None. A blue marker indicates your selection.
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6. Optional: Repeat steps 4 and 5 for the Segment text (2) and Segment text (3) drop down lists.
Selections from Segments (2) and (3) are appended to any Segmented text item you selected
in step 4 the first time.

7. Track texts are applied immediately.

Changing Timeline Track Colors
To change the colors of the tracks in the timeline:

1. Right-click in one of the Timeline tracks.

2. From the menu that opens, click on Sequence Commands > Settings.

3. The Timeline Settings dialog box opens.

4. From the ‘Segment colors based on’ drop down list, select one of the following items:

Cookie Colors are determined by cookie generated by FLOW Story.

Reel Colors are determined by Reel ID.

Picture Format Colors are determined by video clip format.

Track Colors determined by track type; video one color, audio another.

5. Segment colors are applied immediately.
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Working with Tracks on the Timeline
You can work with tracks on the Timeline in several ways. See the following topics:

Selecting Tracks on the Timeline
Each displayed track has a Track Selector button. When the track is enabled, the button is blue;
when it is disabled, it is grey.

Any edits using keyboard shortcuts affect only enabled tracks. A track does not have to be enabled
for you to edit it in the Timeline.

All tracks are enabled by default.

1. Click on a track heading (V1, A1, A2 etc) to disable the track.

2. Click on a disabled track heading to re-enable the track.

3. Right-click on a track heading.:

a. From the menu that opens, click Enable.

b. From the sub menu that opens, select one of the following options:

All: Enable all tracks

None: Disable all tracks

Invert: Enable all disabled tracks and vice-versa

This track only: Enable only the track for the button you clicked

All except this track: Enable all tracks except the one for the button you clicked
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Grouping Tracks in a Sequence
Note: Grouping tracks in the Timeline affects only how they are displayed and edited in the Timeline. They
are still treated as separate tracks for audio routing or video output.

Audio tracks are grouped by default on all new sequences created in FLOW Story.

You can group tracks together so that any edits or trims affect all tracks in a group. This is
particularly useful when you edit stereo pairs. You can group audio tracks together or group video
tracks together in a sequence. However, you cannot group audio and video tracks together.

To group tracks:

1. Right-click on a track in the timeline and, from the menu that opens, select Sequence
Commands > Tracks > Group video, or select Sequence Commands > Tracks > Group Audio.
The Group Video Tracks or Group Audio Tracks dialog box opens, depending on your
selection in step 1.

2. Select Audio tracks or Video tracks from the list.

3. Click OK. The grouped tracks display as a single track in the Timeline.

About Editing Grouped Tracks
You can select cuts on individual tracks for trimming by Shift-clicking them. Edits apply to all
grouped tracks that are currently selected.

Ungrouping Tracks
To ungroup audio or video tracks:

1. Right-click on a track in the timeline and, from the menu that opens, select Sequence
Commands > Tracks > Ungroup. The Ungroup Tracks dialog box opens.

2. Select the Audio tracks or Video tracks from the list and then click OK.

3. Click the group you want to ungroup, and then click OK. The tracks display individually in the
Timeline.
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Trimming Cuts
The main purpose of the Timeline is to make adjustments to the timing of cuts. You do this by
opening or disconnecting the cuts so when you play the sequence, you can move the position of the
cut. When you are finished, you rejoin the cuts. You can unjoin a cut in three places:

● On the outgoing (left) side

● On the incoming (right) side

● In the middle (moving a cut)

You should select the cuts on every track of the sequence to avoid tracks sliding out of sync. After
you select cuts and nudge or play them backwards or forwards, the clip is extended or shortened.
The rest of the sequence is pushed along or pulled back, but is otherwise unaffected.

Auto Track Sync
Auto Track Sync allows the video and audio tracks of a clip to be picked up and moved around the
timeline as one clip. Auto Track Sync also allows all tracks contained in a clip to be trimmed
simultaneously. By default, all trims use Auto Track Sync.

To turn off Auto Track Sync:

1. Right-click in the Timeline and, from the menu that opens, select Sequence Commands >
Auto Track Sync.
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2. Click the Auto Track Sync box to enable Auto Track Sync, or untick to disable it.

3. Holding down the Alt key while trimming, temporarily overrides the current Auto Track Sync
setting, avoiding the need to keep changing the setting.

Trimview
The Trimview feature controls the way that picture trims display on screen.

1. Complete one of the following:

a. Hover your mouse over the clip that you want to trim. When white brackets display,
click the right mouse button.

b. From the menu that opens, select Segment Commands > {Trim Option} - where {Trim
Option} can be Slip, Slide, Trim In, or Trim Out.

c. Press the shortcut key for the Trim option you require.

2. Brackets display in yellow on all tracks next to the cut, denoting that the clip has been
disconnected from the cut.

3. The viewer changes to Trimview mode, displaying frames from the clips on both sides of the
cut.

4. Click the Preview button under the Viewer to play the two clips in sequence.

5. To exit Trim View, click the Close button under the Viewer.
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Trimming an Outgoing Clip
Trimming an outgoing clip changes the end point of the outgoing clip (A) while the start of the
incoming clip remains unchanged (B).

1. You can trim a clip in one of the following ways:

a. Hover your mouse close to the end of the clip you want to trim. When white brackets
display, click the left mouse button.

b. Right-click on the clip you want to trim, and from the menu that opens, select Segment
Commands > Trim Out.

c. Press the Trim Out shortcut key.

2. Brackets display in yellow on tracks, denoting that the clip has been disconnected from the cut.

3. Shorten or lengthen the outgoing clip by doing one of the following:

a. Moving the mouse left or right while holding down the left mouse button. Release the
left mouse button to set the cut point.

b. Pressing the Play button on the viewer. Press Shift+Play to play in reverse.

c. Pressing the play or reverse playback shortcut keys.
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Note: If you see red brackets around the end of a cut point during a trim, you will no longer be able to
trim in that direction as there is not enough media available to extend the clip.

Trimming an Incoming Clip
Trimming an incoming clip changes the start point of the incoming clip (B) while the end of the
outgoing clip (A) remains unchanged.

1. Complete one of the following:

a. Hover your mouse close to the start of the clip you want to trim. When white brackets
display, click the left mouse button.

b. Right-click on the clip you want to trim, and from the menu that opens, select Segment
Commands > Trim In.

c. Press the Trim In shortcut key.

2. Brackets display in yellow on the clip, denoting that it has been disconnected from the cut.

3. Shorten or lengthen the incoming clip by doing one of the following:

a. Moving the mouse left or right while holding down the left mouse button. Release the
left mouse button to set the cut point.

b. Pressing the Play button on the viewer. Press Shift+Play to play in reverse.

c. Pressing the play or reverse playback shortcut keys.

Note: If you see red brackets around the end of a cut point during a trim, you will no longer be able to
trim in that direction as there is not enough media available to extend the clip.
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Moving a Cut
Moving a cut is where both the end of the incoming clip and the start of the outgoing clip move.

1. Complete one of the following:

a. Hover your mouse close to the cut you want to trim. When white brackets display on
both sides of the cut, click the left mouse button.

b. Position the timeline marker over the cut you want to trim, and then press the ‘Move Cut’
shortcut key.

2. Brackets display in yellow on both sides of the cut.

3. Shorten or lengthen both sides of the cut by doing one of the following:

a. Move the mouse left or right while holding down the left mouse button. Release the left
mouse button to set the cut point.

b. Press the Play button on the viewer. Press Shift+Play to play in reverse.

c. Press the play or reverse playback shortcut keys.

Note: If you see red brackets around the end of a cut point during a trim, you will no longer be able to
trim in that direction as there is not enough media available to extend the clip.
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Slipping a Cut
Slipping a clip is where you change the In and the Out points of a clip (B) at the same time.

To slip a clip:

1. Complete one of the following:

a. Hover your mouse cover the start of the clip (A) you want to trim. When white brackets
display, click the left mouse button. Repeat for the end of the clip (B).

b. Right-click on the clip you want to slip, and from the menu that opens, select Segment
Commands > Slip.

c. Press the Slip shortcut key.

2. Brackets display in yellow at both ends of the clip.
3. Change the start and end frames of the clip by doing one of the following:

a. Move the mouse left or right while holding down the left mouse button. Release the left
mouse button to set the cut point.

b. Press the Play button on the viewer. Press Shift+Play to play in reverse.
c. Press the play or reverse playback shortcut keys.

Note: If you see red brackets around the end of a cut point during a trim, you will no longer be able to
trim in that direction as there is not enough media available to extend the clip.
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Sliding a Clip
Sliding a clip is where you move the entire clip (B) up or down the sequence timeline.

To slide a clip:

1. Complete one of the following:

a. Hover your mouse over the end of the first clip (A) you want to trim. When white
brackets display, click the left mouse button. Repeat for the start of the last clip (C).

b. Right-click on the clip you want to slide, and from the menu that opens, select Segment
Commands > Slide.

c. Press the Slide shortcut key.

2. Brackets display in yellow at the end of the first clip and the beginning of the last clip.
3. Shorten or lengthen the outgoing clip by doing one of the following:
4. Move the mouse left or right while holding down the left mouse button. Release the left

mouse button to set the cut point.
5. Press the Play button on the viewer. Press Shift+Play to play in reverse
6. Press the play or reverse playback shortcut keys.

Note: If you see red brackets around the end of a cut point during a trim, you will no longer be able to
trim in that direction as there is not enough media available to extend the clip.
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Reopening Sequences
You can reopen sequences at the points where they were last opened for trimming. We recommend
practising selecting cuts in the Timeline before you start serious work to familiarize yourself with
what happens when you click in different places.

Trimming Shortcut Keys
You can use the following default keyboard shortcuts for trimming:

Trimming Function Shortcut Key

Open tall of previous clip q

Open head of current clip (Trim In) w

Open tail of current clip (Trim Out) e

Open head of next clip r

Slip a clip y

Slide a clip t

Move Cut u

Note that the shortcut keys (q, w, e, r, t, y and u) are the first row of lowercase letters on a QWERTY keyboard.
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Replacing a Clip with Black or Audio Spacing
This is the process of removing part of a clip and replacing it with black in the sequence timeline.
The rest of the sequence is unaffected, only the clip where you unjoined is changed.

1. (Option) Group the tracks to maintain sync.

2. While holding down the Ctrl key, click and drag on the cut you wish to add black to.

Trimming by Numbers
You can type the number of frames by which you want to trim a cut using the numeric keypad on
your keyboard.

1. To trim forwards:

a. Unjoin the cut using one of the trim functions.

b. Press the plus sign (+) on the numeric keypad. The Nudge Forwards dialog box opens.

c. Type the number of frames you want to trim, for example 5, and then press Ok.

2. To trim backwards:

a. Unjoin the cut using one of the trim functions.

b. Press the minus sign (-) on the numeric keypad.

c. The Nudge Backwards dialog box opens.

d. Type the number of frames you want to trim, for example 5, and then press Ok.
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Previewing Trims
You can preview trims by playing or shuttling through cuts while they are unjoined. You can then
make adjustments quickly without needing to join the trim.

To preview trims:

1. Complete one of the following:

● In trim mode, click the Preview button on the viewer.

● Press the Preview shortcut key.

2. The current frame marker jumps back by the preview pre-roll time. The sequence
immediately plays forward across the unjoined cut and continues to play.

3. To stop the preview, click the Stop button or Stop shortcut key.

4. The current frame marker returns to its original position. This is usually at the first trim
point.

5. Adjust the trim using the following controls:

● Playback controls on the viewer

● The shortcut keys on the keyboard

Closing a Trim
To close a trim:

1. Complete one of the following:

● Click the Close button on the viewer

● Click the cut point that you clicked initially to perform the trim

● Press the Join shortcut key.

2. The cut is joined and the Trim viewer reverts to the normal view.
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Undo and Redo
Undo the Last Action
Note: If you undo a trim, pressing Unjoin does not unjoin the cut. Undo returns the sequence to its
previous state, which has no information about future trims made to it.

You can undo your last action as follows:

1. Click the Undo button under the sequence viewer.

Alternatively click the shortcut button for Undo.
You can also use Ctrl+Z (Windows) or Cmd+Z (Mac OS X).

2. The last action is reversed.

3. You can undo up to the last 10 operations.

Redoing Changes
If you click Undo too many times, you can click the Redo button to step back to the previous Undo
operation.

1. Click the Redo button. Alternatively click the shortcut button for Redo.

2. You can also use Ctrl+Y (Windows) or Cmd+Shift+Z (Mac OS X). The last undo action is reversed.

3. You can redo up to the last 10 operations.
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Using Drag-and-Drop
You can copy or move a section of video or audio to a new position in the Timeline using
drag-and-drop. You can also insert or replace clips in the Timeline.

Moving with Drag-and-Drop
To move a section of video or audio to a new position in the Timeline using drag-and-drop:

1. Select the section you want using the Mark and Park method. If you want to move a single
clip, you do not need to use Mark and Park.

2. Place the mouse in the middle of the section you want to move. A double-ended arrow
displays to the right of the mouse pointer.

3. Click and drag the clip to the required point in the timeline; a gap is left where the clip
previously resided.

4. Before dropping the selected material onto the timeline, do one of the following:

● To overwrite material (replace), release the Shift key before releasing the mouse button.

● To insert the section without overwriting material in the timeline, hold down the Shift key.

The tooltip next to the mouse pointer displays ‘Insert’ when the Shift key is held down, and
‘Replace’ when it is released.
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5. When the mouse button is released, the section snaps to the nearest cut point, mark, cue or
timeline marker.

Copying with Drag-and-Drop
To copy a section of video or audio to a new position in the Timeline using drag-and-drop:

1. Select the section you want using the Mark and Park method. If you want to move a single
clip, you do not need to use Mark and Park.

2. Place the mouse in the middle of the section you want to move. A double-ended arrow
displays to the right of the mouse pointer.

3. Press the Ctrl key (Windows) or the Cmd key (Mac OS X) and then drag the clip to the
required point in the timeline.

4. Before dropping the selected material onto the timeline, do one of the following:

● To overwrite material (Replace), release the Shift key before releasing the mouse button.

● To insert the section without overwriting material in the timeline, hold down the Shift key.

The tooltip next to the mouse pointer displays ‘Insert’ when the Shift key is held down, and
‘Replace’ when it is released.

5. When the mouse button is released, the section snaps to the nearest cut point, mark, cue or
timeline marker.
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Inserting or Replacing Clips
You can insert or replace clips into the Timeline using drag-and-drop.

1. In the Content Manager, open a bin containing your clips, in tile or list view.

2. Select the clip you want to add to the timeline by clicking on it, and dragging it to where you
want on your sequence timeline. To select more than one clip, while holding down the Shift
key, click on the clips you want to select.

You can also select multiple clips by Ctrl+clicking (Windows) or Cmd+clicking (Mac OS X).

3. Dropping the selected clip on the timeline replaces the existing clip with your new selection.

4. Holding down the Shift key before dropping on the timeline inserts or adds the clips to the
existing list of clips. The text on the dragged clip(s) changes from Replace to Insert.
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Changing Playback Speed
To change the playback speed of a clip or segment:

1. In the timeline view, right-click on the clip you want to change and, from the menu that
opens, select Segment commands > Speed.

2. The Change Segment Speed dialog box opens.

3. Select the required playback speed from the Speed drop down list, - or type the playback
speed you require directly into the box.

4. Select the playback method as follows:

● Resize: Change the clip duration to be in proportion with the change in playback speed
● Keep start frame: Keep the existing clip length, starting with the first frame
● Keep end frame: Keep the existing clip length, but end with the last frame
● Keep current frame: Keep existing clip length, and centre on the current frame - make

sure you move the timeline marker to the required position beforehand

Note: If you select a speed higher than 100% and do not select Resize, you will have blank video
and audio at one or both ends of the clip.

5. Click Apply.
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Chapter 6: Audio
This chapter describes the basics of audio editing, mixing and audio effects.

Sound clips display in the viewer and the Content Manager as ‘Sound’ on a black background. You
can also create subclips from sound clips and mark them for editing.

Most of the editing procedures in this Chapter use the Mark and Park function. See "Marking a
Section on a Clip" for details on how to use Mark and Park.
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Adding and Removing Audio Tracks
You can add audio tracks to your sequence, for voice overs or to add instrumental tracks to music
projects. You can have up to eight audio tracks.

Adding Audio Tracks
To add new audio tracks:

1. Right-click on the audio track ahead of where you want to insert the new track.

2. From the menu that opens, select Sequence Commands > Tracks > Add audio. The new track
is inserted ahead of the audio track you selected, and the track numbers are renumbered in
sequence: A1, A2, A3, and so on.
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Renaming Tracks
You can change the name displayed against each track in the Timeline window. Note that the track
labels in the sequence viewer remain unchanged. To rename tracks:

1. Right-click on the track header (for example, A1, A2, A3) of the audio track that you want to
rename. Note: clicking on the track itself will not make this menu appear.

2. From the menu that opens, click on Track Commands > Rename.

3. A dialog box opens asking you to enter a new name.

4. Type a new name in the text box.

5. Click Save. The track displays its new name.

Deleting Audio Tracks
To delete audio tracks:

1. Right-click on the track you want to delete.

2. From the menu that opens, select Sequence Commands > Tracks > Delete. A dialog box
opens, displaying a list of tracks to delete.

3. Click to select or deselect the tracks you want to delete and click the OK button. The tracks
are deleted and the track numbers are renumbered in sequence. For example: A1, A2, A3.
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Turning Audio Tracks Off and On
It is often useful to mute audio tracks that could be distracting, for example all voice over tracks
except for the audience’s native language.

1. Click on the track number to mute audio from that track. The track number dims to indicate
that audio is muted.

2. Click again on the same track to re-enable audio from that track. The track number
brightens to indicate that audio is enabled again.
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Audio Waveforms and Levels
Displaying Audio Waveforms
You can hide or display audio waveforms on audio tracks, and you can choose Pre or Post Level
waveforms. Pre Levels refer to the original level of the audio clips, and Post Levels refer to
adjustments you subsequently make to audio levels.

1. Make sure the Edit or Audio tab is selected.

2. Right-click on any track in the timeline and, from the menu that opens, select Sequence
Commands > Settings. The Timeline Settings dialog box opens.

3. Under Audio > Show waveforms, select No, Pre Levels or Post Levels from the drop down
list.

4. If you selected Pre Levels or post Levels, Audio waveforms display in the audio tracks.

5. To see the waveforms more clearly, resize the Timeline. See "Navigating the Timeline".
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Displaying Audio Levels
To display audio levels:

1. Make sure the Edit or Audio tab is selected.

2. Right-click on any track in the timeline and, from the menu that opens, select Sequence
Commands > Settings. The Timeline Settings dialog box opens.

3. Under the Audio heading, click on the ‘Show levels’ checkbox to toggle the audio levels off
and on.

Changing Audio Levels
Audio levels settings apply only to individual clips within a sequence, or cut point to cut point. To
boost or lower the audio level of a clip:

1. Make sure the Audio tab is selected.

2. Park the timeline marker anywhere in the clip.

3. Hold down the shift key and hover your mouse over the white level marker on the audio
track you want to adjust until the cursor displays a double-ended arrow.

4. Hold down the left mouse button and drag the line up or down until you achieve the
required audio level.

5. Repeat steps 2 to 4 for each audio track that you want to adjust.
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Using Nodes to Set Audio Levels
You can set nodes on the audio tracks and use them to adjust audio levels as described below:

1. Make sure the Audio tab is selected.

2. On the selected audio track, click on the white line at the point where you want the change
in audio level to start. This creates the first node, which displays as a square when you hover
the mouse over the white line.

3. On the selected audio track, click on the white line at the point where you want the change
in audio level to finish. This creates the second node.

4. Press and hold down the mouse button over the second node, and drag it up or down to the
required audio level.

5. Repeat steps 3 and 4 to add more node points and to set their audio levels.

Removing Audio Nodes
To remove all audio nodes from a clip:

1. Make sure the Audio tab is selected.

2. Right-click on the track containing the nodes you want to remove and, from the menu that
opens, select one of the following items:

● Reset segment levels (removes nodes from the current segment only)

● Reset track levels (resets all segments for the audio track you clicked)

3. All nodes from the clip are removed.
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Deleting Selected Audio Nodes
To delete selected audio nodes from a clip:

1. Make sure the Audio tab is selected.

2. Hold down the left mouse key and trace a rectangle around the nodes that you want to
delete. The nodes you select are highlighted in yellow.

3. Right-click in the track and, from the menu that opens, select Delete selected levels. The
selected nodes are removed.

Deleting Individual Audio Nodes
1. Make sure the Audio tab is selected.

2. Hold down the Ctrl key and click on the node you want to delete.

3. Right-click in the track and, from the menu that opens, select Delete selected levels. The
selected node is removed.

Copying Audio Nodes
You can make changes to the audio levels made in one clip and apply the settings to another clip by
copying the nodes. Audio levels are copied over while the audio content remains unchanged in the
target clip.

1. Make sure the Audio tab is selected.

2. Hold down the Alt key and click and hold the middle of the clip that contains the audio levels
you want to copy.

3. Drag the section to the destination clip in the sequence timeline.

4. Release the mouse button.
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Audio Fade-In and Fade-Out
You can create an audio fade in or fade out on a clip, as follows:

1. Make sure the Audio tab is selected.

2. In the timeline, position your mouse over the audio track you want to apply a fade in or fade
out.

3. A small triangle displays at the top left (A) and top right (B) corners of the track.

4. Do one of the following:
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● To create a fade in, position your mouse over the triangle at the top left corner of the
audio clip (A) until the cursor changes to a double-ended arrow.

● To create a fade out, position your mouse over the triangle at the top right corner of the
audio clip (B) until the cursor changes to a double-ended arrow.

5. Hold down the left mouse button and drag the triangle out to the desired position.

6. The duration of the fade, in frame displays in the track, while the slope of the triangle
indicates the rate of audio fade in or fade out.

7. Release the mouse button when you have the required duration of fade in or fade out.

Replacing Sound with Atmos
Atmos, also known as atmosphere, ambience, background or wild track, is a soundtrack for a given
location or space. Atmos can consist of music, wind, rain, running water, traffic, machinery, and so on.
It is recorded separately, without dialog, and inserted later into the main soundtrack of your project.

1. Make sure the Edit tab is selected.

2. In the sequence timeline, deselect the video track.
3. Select only the audio tracks you want to change
4. Select a section in the sequence viewer using the Mark and Park method.
5. Browse to the Atmos audio file you require, and Mark and Park the section you want to use.
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6. Do one of the following:

● Press the Replace shortcut key.
● Drag and drop the Atmos tile onto the sequence timeline.

7. The marked tracks are replaced by the audio from the Atmos file.

Voice Overs
One of the advantages of FLOW Story is the ability to add voice over tracks quickly to existing
sequences. You can specify an existing audio track for your voice over, add a track manually or let
FLOW Story add one for you. To add a voice over to your sequence:

1. Click the Edit tab.

2. Load the sequence into the viewer.

3. Move the timeline marker to where you want to start your voice over.

You may find it helpful to mute the sound on all of the audio tracks when making your
recording. See "Turning Audio Tracks Off and On".

4. Click on the Microphone icon below the viewer to open the Record dialog box. If you have
not already done so, set the recording options described below:

a. Select the microphone you want to use from the Device drop down list. Select from
Internal Microphone, External Microphone or another device displayed in the list.
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Note: FLOW Story can only ‘see’ the microphone if it is enabled at the operating system level.

b. Sound levels display on a bar below the Device drop down list.

c. Select the track you want to record your voice over from the Track drop down list.

d. Select the pre-roll time for your voice over by selecting a value from the Preroll drop
down list, or type a value of your own.

5. Click Record. The Record button changes to the End button.
6. When the status label changes to ‘Recording’, start speaking into the microphone.
7. To stop recording, click the End button.
8. Your Voice Over displays in the track you selected.

Using the Audio Mixer
The Audio Mixer allows you to control and mix all the audio tracks in your project. You can set the
levels and spatial positioning of each track, left and right. The mixer panel can be found on the
Audio tab.

1. Click on the Audio tab. The Audio Mixer displays in the top right area of the desktop. All the
available audio tracks are displayed, each with its own sound level indicator.
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2. The track for the mixer output is labeled LR.

3. To adjust the sound level for each track, slide the adjacent (blue) volume control up or down.
Click on the track to reset it to its default level.

4. To adjust the overall sound level, slide the LR volume control up or down. Click on the LR
track to reset it to its default level.

5. Click the track indicator to enable or disable its output.

6. To monitor the output of one track and mute the other tracks, click on the Solo button for
the track you want to hear. The Solo button illuminates to indicate that it is selected.

7. Click and drag the pan indicator to specify the volume for each audio channel.

Audio Effects
You can apply various audio filters and crossfades to whole clips and marked sections in your
sequences.

Applying an Effect to a Marked Section
To apply an audio effect to a marked section:

1. Select the Audio tab and load the sequence containing the clip that you want to edit.

2. Mark the in and out points of the section that you want to apply the effect to.

3. Select the effect you want to apply from the Components list.
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4. Select Marked Section from the Target region drop down list.

5. Click the Apply effect button.

6. The chosen effect is applied to the marked section of the sequence.

Applying an Effect to Matching Clips
Applying an audio effect to matching clips is useful when you have many video clips, for example in
an interview, that you want to apply the same audio effect to. Instead of doing each of these
individually, you can select to apply the audio effect to matching clips (those with the same video).
To apply an audio effect to matching clips:

1. Select the Audio tab and load the sequence containing the clip that you want to edit

2. Add an effect to the timeline that can be applied to multiple clips, for example EQ.

3. Select Matching Clips from the Target region drop down list.

4. The Criteria field is revealed below the Target region drop list.

5. Build the criteria that matches the clips you require from the Attribute, Match and Pattern drop
down lists and text box. For example apply the effect to any clips that have the name ‘Interview’.

The Attribute drop down list contains items such as Name, Take, Scene and Comments. The
Match method drop down list provides equals, contains, doesn’t equal, doesn’t contain and
doesn’t contain as matching options, while the Pattern text box accepts any combination of
alphanumeric characters.

6. Click the Apply effect button.

7. The chosen effect is applied to the timeline.

114



Audio Effect Options
Crossfade
Provides a smooth transition from the outgoing audio tracks to the incoming audio tracks. There are
no settings for this transition.

Equalization (EQ)
An effect control which boosts or reduces the energy of audio over prescribed frequency ranges. Each
EQ effect has five sub-bands which can be used in combination to create complex equalization profiles.

1. Select the Audio tab.

2. Click the Add Effect button ‘+’.

3. Select EQ under the components heading.

4. The effect opens with the Band 1 tab selected:

5. Select the filter you require from the Filter Type drop down list. The options are:

● Low pass
● High pass
● Band pass (constant skirt)
● Band pass (constant peak)
● Notch
● Peaking EQ
● Low shelf
● High shelf
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6. A profile of the selected filter displays in the graph area. In the picture above Low Pass is selected.

7. Enter the frequency threshold (e.g. cut-off frequency for low/high pass filters, centre
frequency for notch filters) in the Frequency (Hz) text box. Alternatively, drag the orange bar
under the box to the setting you require.

Alternatively, drag the orange bar under the box to the setting you require.

8. Type the required Q-Factor value in the corresponding text box. Q-Factor is the quality or
sharpness of the filter envelope.

Alternatively, drag the orange bar under the box to the setting you require.

9. Optional: Repeat steps 2 to 5 to apply further filters as required in the Band 2, Band 3, Band
4 and Band 5 tabs.

10. You can review the difference a filter makes to the overall effect by toggling OFF or ON the
LED for each Band.

EQ Presets
The following presets are available to deploy common equalization requirements such as removing
mains hum, wind noise and so on. Each preset resides in Band 1, leaving the other bands empty,
allowing you to set further effects.

50Hz Hum Removal - A notch filter to remove 50Hz mains hum

60Hz Hum Removal - A notch filter to remove 60Hz mains hum

Treble Boost - Lift or boost signals above 2 kHz

Increase VO Presence - Gentle lift to mid band frequencies to give extra presence

LoFi EQ - Simulates a small speaker

Loudness Curve - Lifts low end and high end frequencies with a slight drop mid band. Gives the
listener better audible spectrum response at low volume levels.

Low End Booster - Boosts bass frequencies

Mic Wind Reduction - High pass filter to help reduce wind noise in field recordings

Mix Master EQ - Global master mix EQ

Plosive Reduction (PQ) - Reduce low frequency effect of popping B’s and P’s in vocal recordings

Reduce Female Sibilance (5-7 kHz) - Controls S’ and T’s. Boost first then sweep EQ frequency from
5-7 kHz to identify a problem sibilance in a female vocal recording. Then use ‘Cut’ to preference.
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Reduce Male Sibilance (4-6 kHz) - Controls S’ and T’s. Boost first then sweep EQ frequency from 4-6
kHz to identify a problem sibilance in a male vocal recording. Then use ‘Cut’ to preference.

Reduce Soundtrack Presence -  Apply a slight reduction in the vocal audio range to help a voice over
to sit better over a musical soundtrack.
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Chapter 7: The Project Card
The Project Card allows you to review details about your project, and to change various output settings.

Opening the Project Card
To review or update information in your project:

1. Click on the arrow on the Project tab at the top left corner of the screen to open the project card.

2. The Project Card opens. The following tabs display across the top of the card:

● Details

● Video

● Media

● Preferences

● Tasks

3. You can review and update the Project tabs as described in the following sections.

4. To close the Project Card, click on the Project tab again, or click anywhere outside the Card.
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Details Tab
The Details tab displays general information about the project.

1. If the Details panel is not visible, click on the Details tab to reveal it.

2. To rename the Project, double-click on the Project name, type the new project name directly
into the text box, and press Enter. The new name displays at the top of the Project Card and
in the associated project tile of the Project Browser.

3. The Frame rate field displays the frame rate for the project and is read-only.

4. The Creation date field displays the date and time when the project was created. The field is
read-only.

5. The location of the Project folder displays below the Creation date. Click on the location
name to open a file manager in the Project folder.

6. You can select what metadata (data about the project) Displays by selecting a template from
the drop down list.

7. You can select which users can view the project by using the Can be viewed by drop down list.

8. You can select which users can modify the project by using the Can be modified by drop
down list.

9. You can type notes about the Project directly into the Notes text box.
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Video Tab
FLOW Story can scale video in real time to play out video in any compatible format, regardless of the
source material format. You can also select letterboxing and aspect ratio options.

Video options are divided into tabs. See the following topics:

● "Output Tab"
● "Letterbox Tab"
● "R3D Tab"

Output Tab

Use the Output tab to review and update general playback options:

1. If the panel is not visible, click on the Output tab to reveal it.

2. Select the format you require from the Output Format drop down list.

3. The Full SD Frames field is active only when the Output format field is set to a standard
definition format.

4. Select the playback mode from the ‘Playback media selection’ drop down list.

Set the media playback quality to Hi-Res (only if you are connected locally to the network) or
to proxy media. The ‘Automatic’ setting lets FLOW Story set playback quality. For example:

● Only proxy files are played when playing a tile or a viewer at a small size.
● Hi-Res files are used when viewing full screen or in a large viewer, and assuming that

you are on a local network.
● When working remotely, a proxy file is always streamed.
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You can decide to download proxy, Hi-Res files or both, in which case you can then decide
which media type to view.

5. Select options as described in the following table.

Aspect Ratio Conversion Full Frame Full Zoom Partial Zoom

Displaying narrow as wide
(4:3 as 16:9).

The entire image
displays with black
bands on each side.

The 4:3 image is enlarged so
it fills the width of the 16:9
frame. The top and bottom
of the 4:3 image are cut off.

A medium
enlargement.

Displaying wide as narrow
(16:9 as 4:3).

The entire image
displays with
letterboxing at top and
bottom.

The 16:9 image is enlarged
so it fills the height of the 4:3
frame. The left and right
sides of the 16:9 image are
cut off.

Note: source material with 4:3 and 16:9 aspect ratios can be contained together in the same project or edit.

6. Select whether to apply VFR correction. VFR stands for Variable Frame Rate, a video
compression technique that allows the frame rate of footage to change during playback.
Most phones and cameras shoot variable frame rate media. You can choose from the
following options:

● Yes - Corrects video and audio synchronization for variable frame rate media, for
example footage recorded from mobile phones.

● No - Does not apply any correction for variable frame rate media - audio will be out of
sync with video, for example can be used for time lapse footage where the audio sync is
not required.

7. You can load the default FLOW Story Look Up Table (LUT) or load your own LUT into a
location FLOW Story can access when you click the Browse button.

● To enable the LUT, click the LED icon. The LED changes to green to indicate it is enabled.

● To disable the LUT, click the LED icon again.
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Letterbox Tab

Use the Letterbox function to crop your video material:

1. Open the clip, subclip or Edit you want to crop.

2. With the Video tab open, click on Letterbox.

3. The currently selected clip displays in the main viewer in the Letterbox panel.

4. Type the number of pixels you wish to crop from the top and bottom of the video frame into
the Top and Bottom text boxes respectively.

5. You can also set the number of pixels to crop by clicking and dragging the mouse from the
top or bottom video frame.

6. Alternatively, click on ‘From picture’. This lets FLOW Story calculate the picture cropping for
you.

7. Click on Apply to apply the changes you made.

8. Click the Affect output monitor(s) box to apply cropping to connected monitors.
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BRaw Tab

To review BRaw (BlackMagic RAW) settings:

1. With the Video tab selected, click on BRaw.

2. Set the BRaw Decode Quality from the drop down list.

3. Set the source for the BRaw decode, the following options are enabled:

● Project

● Camera

● Default
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R3D Tab

To review R3D settings:

4. With the Video tab selected, click on R3D.

5. Set the RED decode quality from the drop down list. See "RED (R3D) Files" for information
about importing RED files.

6. Set the source for R3D decode settings from the Decode Using drop down box. If you select
‘Project Settings’, the following options are enabled:

● Kelvin

● Tint

● Exposure

● Saturation

● Contrast

● Brightness
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Media Tab
You can specify any media location for your Material and Sound folders, and you can add as many
media locations as you want. This is very useful if you need to manage media on a project per
project basis.

Creating, Selecting and Removing Import Destinations

To create, select or remove an import destination, see "Import Destinations" for further information.

Reviewing Media Locations and Free Disk Space

To check the amount of free space on your media location and drives:

1. Open a Project Card, and click on the Media tab.

2. Click on the Locations tab if it is not already selected.

3. The amount of free disk space for each media location displays in the Locations tab.

4. To add a new media location, click the Add button. When the file manager window opens,
navigate to the folder, drive or network location you want to use, and then click OK.

5. To remove a media location,

a. Click on the location in the Locations tab, and then click Remove. A dialog box opens,
asking you to confirm you want to remove the location.

b. Click OK to remove the location or Cancel to stop the deletion.
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Transcoding Tab

To review or update transcoding settings:

1. With the Media tab selected, click on Transcoding.

2. For SD Media:

a. Select the required file format from the File type drop down list.

b. Select the compression method from the Compression drop down list.

3. For HD Media:

a. Select the required file format from the File type drop down list.

b. Select the compression method from the Compression drop down list.
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Preferences Tab
FLOW Story allows you to drag clips, subclips and sequences out of the application and into other
applications such as AVID Media Composer and Final Cut Pro X using AAF or XML.

1. With the Preferences tab selected, click on the Auto drop down list.

2. Select from the following options:

● Auto (default) - detects which application you are attempting to drop to, and will
generate the correct file based on the target application.

● AAF - compatible with AVID Media Composer.

● XML (FCPX) - compatible with Apple Final Cut Pro X.

● XML (FCP7).

● Adobe Premiere.
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Tasks Tab
The Tasks tab displays current background tasks such as publishing a sequence.

1. Publish a sequence. See “Publishing Sequences”.

2. Click the Tasks tab.

3. The publishing task is running with the Active sub tab selected.

4. Click on the thumbnail render image to open the progress of the publishing task, and view
the sequence in a larger window.

5. To cancel the task, click the Abort button.

6. You cannot exit a project while background tasks are in progress.

7. To review recent tasks, click on Recent.
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Chapter 8: Bins and Groups
This chapter covers generic features for bins and describes how you can use them to manage
projects.

Working with Bins
Bins are used to organize and display your clips and sequences. You can move and copy clips to
other bins, and change the way bins display clips. A bin is the equivalent of a folder in FLOW Story
and AirFLOW.

You can also group bins by placing them in another bin. Grouped bins display as folders within a
folder in AirFLOW. However, if an AirFLOW user moves a clip into a parent folder, it is no longer
viewable in FLOW Story.

It is possible for a clip to be in more than one bin at the same time. You can use this feature to help
organize your material more flexibly. Be aware that seeing a clip in more than one place on the
screen does not mean there is more than one copy of the clip on the hard disk.

Creating a Bin with Clips
You can create an empty bin, or you can select the clips you want when you create the bin as
described in the following procedure:

1. Select a filter under the project contents, for example Clips, Subclips, or Sequences, and
press Click on the clips you want in your bin. To select multiple clips, hold down the Shift or
Ctrl key, and then click on each clip you want to move.

Mac OS X users should use the Cmd key instead of the Ctrl key.

2. Right-click on the clips and, from the menu that opens, select Bin Commands > Make > Bin
from selection.

3. A bin called All #1 is created in the Contents List. If the bin already exists, the last number
in the name is incremented.
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Changing a Bin’s Appearance
You can change the appearance of a bin in a number of ways:

1. Click the View button to toggle between List and Tile views.

2. Click on the right or bottom edge or corner of the bin and drag it to the size you want.

If you make a bin smaller, you may be unable to see all of the columns and fields on the
screen at the same time. Use the scroll bars A and B to show items outside the viewing area
of the bin.

3. Click on a Bin name to display its contents in the main viewing area.
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Renaming Bins
To rename a bin:

1. Click on the bin name entry in the Content List panel.

2. Type a new name for the bin and then press Enter.

Moving Clips between Bins
To move one or clips:

1. Open the bin containing the clip or clips you want to move.

2. Click on the clip you wish to move. To select multiple clips, hold down the Shift or Ctrl key,
and then click on each clip you want to move.

Mac OS X users should use the Cmd key instead of the Ctrl key.

The cursor changes to show you how many clips you have selected.

3. Release the Shift, Ctrl or Cmd key, and drag the selected clips onto the intended bin.
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Copying Clips to Bins
To copy one or more clips:

1. Open the bin containing the clip or clips you want to copy.

2. Click on the clip you wish to copy. To select multiple clips, hold down the Shift or Ctrl key,
and then click on each clip you want to copy.

Mac OS X users should use the Cmd key instead of the Ctrl key.

The cursor changes to show you how many clips you have selected.

3. Hold down the Ctrl key and drag the selected clips onto the intended destination. Mac OS X
users should use the Cmd key instead of the Ctrl key.
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Deleting a Bin
To delete a bin:

1. Right-click on the bin you want to delete and, from the menu that opens, select Delete.

2. To select multiple bins, hold down the shift or Ctrl key (Cmd key for Mac OS X) while clicking
on the bins you want to delete and, from the menu that opens, select ‘Delete selected bin(s)’.

3. The Remove/Delete dialog displays.

4. Select the items you want to delete.

● Remove clips from the project - the clips in the bin are deleted from the project.

● Delete bins - only the bin is deleted. Any clips or sequences contained in the bin are not
deleted.

● Delete local proxy media - the proxy media that is local to your machine and associated
with the bin is deleted.

● Delete local media files - the media files that are local to your machine and associated
with the bin are deleted.

● Delete remote clip metadata - the metadata associated with remote clips in the bin is deleted.

● Delete remote proxy media - the remote proxy media that is associated with the bin is deleted.

● Delete remote media files - the remote proxy media files that are associated with the bin
are deleted.

● Delete nearline media - nearline media that is associated with the bin is deleted.

● Delete archived media - Archived media that is associated with the bin is deleted.

5. Select the item(s) you want to delete.

6. Click Remove to confirm the deletion.
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Working with Groups
Groups are a collection of bins and other groups. They display in the Content List, and can also be
identified by an amber marker that can be clicked to expand or collapse items contained in a group.

A group has the following properties:

● Groups can be minimized to save space or left open to show content in the Content
Manager

● Bins can be dropped into single or multiple Groups

● Groups can be placed in other groups

Creating a New Group
To create a new group:

1. Complete one of the following:

● Right-click in the Content List panel and select Make > Empty group.

● Select multiple bins by Shift or Ctrl-clicking them, then right-click. From the menu that
opens, select ‘Make Group’.

2. A new group is created.

Renaming a Group
To rename a group:

1. In the Contents List, double-click on the group’s name and then type the new name.

2. Press Enter.
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Adding Bins and Groups to a Group
To place a bin or a group inside another group:

1. Click on the bin or group, and drag it onto the group you want to move it to.

To select multiple bins and groups, hold down the Shift or Ctrl key (Cmd key for Mac OS X)
while clicking.

2. When the destination group is highlighted, release the mouse button. The selected bins and
groups display inside the Group.

Removing Bins from a Group
To remove bins from a group:

1. Click on the bin you want to remove and drag it out of the group into an empty space in the
Content List panel.

To select multiple bins, hold down the Shift or Ctrl key (Cmd key for Mac OS X) while clicking.

2. The bin displays in the Content List panel but is no longer part of a group.

Removing (Ungrouping) Groups
To remove a group from the Content List panel, right-click on the group you wish to remove and
from the menu that opens, select Ungroup. The group is removed from the Content List panel, and
all bins within the group display as independent bins.

Sorting Bins and Groups
You can sort the order of bins and groups by date, name and type:

1. Right-click in the Contents List area of the Content Manager and, from the menu that opens,
select Ordering > Sort by.

2. From the sub menu that opens, select Date, Name or Type.

3. Bins and groups are sorted into the order you specified.
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Tile View
Sorting Tiles
To change the order in which tiles are displayed:

1. Open a Bin or Filter containing media. Set the Bin or Filter to Tile View.

2. Right-click on a tile and, from the menu that opens, select View Commands > Sort By.

3. Select Tile View in the Content Manager.

4. Right-click on a tile and, from the menu that opens, select View Commands > Sort By.

5. Select the sort option you require from the drop down list that opens.
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Changing the Thumbnail Size in Tile View
In Tile View, while holding down the Ctrl key, move your mouse over an area of the bin and scroll
with the mouse wheel to change the thumbnail size. Changing the size of thumbnails in Tile View
does not affect the size of thumbnails in List View.

Alternatively:

1. Set the Content Manager to Tile View.

2. Right-click on a tile and, from the menu that opens, select Tile Size > Small, Medium or Large.
The size of thumbnails is set to the size you selected.

List View
When in the List View you can see metadata about each clip, such as tape name, clip name and
creation date. Custom metadata, if set, will also appear in this view. You can select the columns that
you see in List View and save it as a default view.

Sorting the List View
You can sort the List View alphanumerically by Name, Tape, Comments, or by any other visible field column:

1. In List View, click on the column you want to sort on.

2. The List items are sorted on the column you selected.
3. To reverse the list order, click again on the same column.
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Changing Thumbnail Size in List View
In List View, while holding down the Ctrl key, move your mouse over an area of the bin and scroll
with the mouse wheel to change the thumbnail size. Changing the size of thumbnails in List View
does not affect the size of thumbnails in Tile View.

Alternatively:

1. Set the Content Manager to List View.

2. From the menu that displays, select View Commands > Thumb Size > Extra Small, Small,
Medium, Large or Extra Large. The size of thumbnails is set to the size you selected.

Displaying Bin Columns
You can display bins and the items in them in different ways. You can store several views within a
project and customize them with all or only some of the fields in the bin. Views can help you
organize the bin information.

1. Select the bin that you want to view.

2. Click the list view button if you are in the tile view display.

3. Right-click in the Columns area and, from the menu that opens, select which columns you
want to display by selecting their checkboxes.
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Changing the Order of Fields
To change the order of column fields:

1. Click the list view button if you are in the tile view display.

2. Right-click in the Columns area.

3. Drag and drop the column header to a new position in the list view bin.

Saving a View
To save a view:

1. Right-click in the Columns area and, from the menu that opens, scroll down and select
Presets > customize.

2. In the Customize Columns dialog box, click Save. A Save as dialog box opens.

3. Type a name for the view, and click Save. The named view is saved and added to the list
displayed when you open the Columns list in the bin menu.

Deleting a View
To delete a view:

1. Right-click in the Columns area and, from the menu that opens, scroll down and select
Presets > Customize.

2. Click Delete.

3. Click on the view you want to remove, and then click Ok.

4. A message box opens, asking you to confirm you want to delete the view. Click Yes to delete,
or No to cancel the deletion.
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Merging Content from Multiple Bins
You can create new bins which combine some or all of the content from two or more existing bins.
You can also rename the bins generated to something more meaningful to you.

Merging all Content
You can merge the contents of two or more bins into a new bin, leaving the contents of the source
bins unchanged. Do the following:

1. While holding down the Shift or Ctrl key (Cmd key for Mac OS X) click on the source bins you
wish to merge.

2. Release the Shift or Ctrl key (Cmd key for Mac OS X) and right-click on your selection.

3. From the menu that opens, select Selection > Make > Bin (union). A new bin called Union #1
is created, containing the media from the selected bins. If there is already a bin called Union
#1, the next available number is used. The tagged records from the selected bins are added
to the destination bin.

Merging Common Content Only
You can select content that is common to two or more bins and place them into a new bin, leaving
the contents of the source bins unchanged. Do the following:

1. While holding down the Shift or Ctrl key (Cmd key for Mac OS X) click the source bins you
wish to merge.

2. Release the Shift or Ctrl key (Cmd key for Mac OS X) and right-click on your selection.

3. From the menu that opens, select Selection > Make > Bin (intersection). A new bin called
Intersection #1 is created, containing the media that is common to the selected source
bins. If there is already a bin called Intersection #1, the next available number is used.
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Merging Unique Content Only
You can select content from two bins that is not common to each other and put them into a new
bin. The contents of the source bins remain unchanged. Do the following:

1. While holding down the Shift or Ctrl key (Cmd key for Mac OS X) click the source bins you
wish to merge.

2. Release the Shift or Ctrl key (Cmd key for Mac OS X) and right-click on your selection.

3. From the menu that opens, select Selection > Make > Bin (difference). A new bin called
Difference #1 is created, containing all the media that is unique to each selected bin. If
there is already a bin called Difference #1, the next available number is used.

Making Proxies
If you have very large media files you may find they run slowly or jerkily on your system. You can
improve the playback response of your media if you play proxy versions of your files instead. You
can set Lightworks to play proxy versions instead of your original high resolution files from the
Project Card Video tab.

To create proxy files from your media:

1. Right-click on a clip or a bin of clips.

2. From the menu that opens, select Media -> Make proxy(ies). The Task tab of the Project Card
opens to display the progress of Proxy file generation. When all proxies are created, the
Project Card closes.
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Chapter 9: Transitions
You can add various transitions to your sequences, including fades, dissolves and wipes. You can
use these to convey a tone or mood, suggest the passage of time, or separate parts of a story.

Adding and Changing Transitions
Adding Simple Transitions
To add a simple transition:

1. Select the VFX tab.

2. Right-click on the cut where you want your transition.
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3. From the menu that opens, select Transitions > Position, and choose where you want the
transition to start and finish from the drop down list.

The options are:

● Centered Here (default) - Applies the effect centered at the park position.

● From Here - Applies the effect forward from the park position.

● To Here - Applies the effect backward from the park position.

4. Select the number of frames you want for your transition to take effect from the Length
drop down list.

5. Click on Add, and select one of the Transition options. The transition is applied to your
sequence.

NOTE: If there is not enough media on either of the clips for the transition, the effect will not be added to
the timeline.

Changing a Video Transition
To change an existing video transition:

1. In the timeline, right-click on the video transition you want to change.

2. From the menu that opens, select ‘Replace with..’ and then select the transition you want
from the submenu.
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Configuring a Transition
Each transition has its own configuration dialog box which displays all the parameters available for
that effect. To configure a transition:

1. Complete one of the following:

● In the Edit tab right-click on the transition in the timeline and, from the menu that opens,
select Transitions > Settings.

● The settings panel on the VFX tab is opened.

2. A Configuration panel opens on the left hand side with the Settings tab open.

3. If the effect view is collapsed, click on the side arrow to expand it.

4. Make the changes you require, following the instructions for the relevant transition listed
under "Transition Types" on.

5. If the timeline marker is parked within the effect, changes display immediately in the
Sequence viewer and on the output monitor.

6. Click on the green button to toggle the transition ON and OFF. The button displays green
when the transition is enabled.

7. To remove or reset an effect, click on the Cogs icon. From the menu that opens:

● Click on Reset to revert all settings to their default values.

● Click on Remove to delete the transition from the timeline.
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Adding Audio Transitions
To add an audio transition which has the same duration as the video transition:

1. Select the Edit tab.

2. Right-click on the audio cut where you want to add your transition.
3. From the menu that opens, select Transitions > Add Dissolve.

4. The Dissolve transition is applied to the audio tracks.
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Transition Types
Dissolve
Simulates a film-type dissolve.

1. Select the VFX tab.

2. Click the plus + icon next to the settings heading.

3. The Mix transition group is selected as default.

4. Click the drop down arrow next to Dissolve to open the options.

5. The rate of Dissolve can be adjusted by sliding the Progress slider left or right.

Luma Wipe
The Luma Wipe effect is a transition between images based on their luminance, and can be adjusted
as follows:

1. Select the VFX tab.

2. Click the plus + icon next to the settings heading.

3. The Mix transition group is selected as default.

4. Click the drop down arrow next to Luma Wipe to open the options.
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5. Set the Luma source - Foreground or Background - from the Luma source drop down list.

6. Click on the Border menu to expand it.

● Size: Controls the border size of the wipe.

● First color: Sets the first color of the wipe.

● Second color: Sets the second color of the wipe.

7. Move the Softness slider left or right to adjust the sharpness of the wipe.

8. Move the Progress slider left or right to alter the rate at which the wipe occurs.

9. Select the Invert box to reverse the direction of the wipe.

Push
The transition between two elements made by one element pushing another off the screen. The
Push effect can be adjusted as follows:

1. Select the VFX tab.

2. Click the plus + icon next to the settings heading.

3. The Mix transition group is selected as default.

4. Click the drop down arrow next to Push to open the options.
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5. Set the direction of the push (left, right, up or down) you require from the Type drop down list.

6. Move the Progress slider left or right to alter the rate at which the push effect occurs.

Squeeze
The transition between two elements made by one element entering the screen while squeezing
down the other. It can be adjusted as follows:

1. Select the VFX tab.
2. Click the plus + icon next to the settings heading.
3. The Mix transition group is selected as default.
4. Click the drop down arrow next to Squeeze to open the options.
5. Set the direction of the squeeze (left, right, up or down) you require from the Type drop

down list.

6. Move the Progress slider left or right to alter the rate at which the squeeze effect occurs.
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Wipe
Wipes the screen, transitioning between outgoing and incoming elements. The Wipe effect can be
adjusted as follows:

1. Select the VFX tab.

2. Click the plus + icon next to the settings heading.

3. The Mix transition group is selected as default.

4. Click the drop down arrow next to Wipe to open the options.

5. Set the wipe pattern you require from the Wipe drop down list. To assist you, each item in
the list has a preview of the wipe action.

6. Move the Softness slider left or right to adjust the sharpness of the leading edge of the wipe.

7. Move the Progress slider left or right to alter the rate at which the wipe effect occurs.

8. Tick the Reverse direction box to reverse the direction of the wipe - for example, a wipe that
previously wiped from left to right wipes from right to left.

9. Click on the Repeats menu to expand it.

● Across: Controls the horizontal position of the wipe effect.

● Down: Controls the vertical position of the wipe effect.

10. Click on the Border menu to expand it.

● Size: Controls the border size between the two sides of the wipe.

● First color: Sets the first color of the wipe border.

● Second color: Sets the second color of the wipe border.

11. Click on the Position menu to expand it.

● Horizontal Position: Change the horizontal position of the wipe border.

● Vertical Position: Change the vertical position of the wipe border.
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Chapter 10: Effects
FLOW Story includes a wide range of visual effects including Chromakey, Mirror, Titling and Picture
in Picture effects.

You can also apply visual effects using the Video Routing Panel as described in "Chapter 11: Video
Routing Panel".

Adding an Effect from the Timeline
To add an effect from the timeline menu:

1. Select the VFX tab.

2. Use Mark and Park to highlight the section you want to add your effect to.

3. Right-click on the timeline and, from the menu that opens, select Effects > Add, and choose
the effect you want from the sub menu.

4. The effect is inserted into the timeline.

5. Configure your effect as described on "Configuring an Effect".
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Adding an Effect using the Add Button
To add an effect using the Add button:

1. Select the VFX tab.

2. Use Mark and Park to highlight the section to which you want to add your effect.

3. Click the Add Effect button ‘+’.

4. Select the Effects category containing the effect you want from the drop down list.

5. Click to select the effect you want from the Category panel.

6. Select what you want the effect applied to from the drop down list.

7. Click the Apply effect button.

8. The effect is inserted into the timeline.

9. Configure your effect as described on "Configuring an Effect".
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Configuring an Effect
Each effect has its own configuration dialog box which displays all the parameters available to it. To
configure an effect:

1. Complete one of the following:

● With the Edit or VFX tab open, right-click on the clip that you want to configure the effect
for and, from the menu that opens, select Effects > Settings.

● With the VFX tab open, position the timeline marker over the effect and then click on the
Settings tab.

2. Click the plus + icon next to the settings heading.

3. A Configuration panel opens on the left hand side of the VFX tab.

4. If an effect view is collapsed, click on the side arrow to expand it.

5. Make the changes you require, following the instructions for the relevant effect, as described
in the following sections:

● "Digital Video Effects (DVE)"

● "Key Effects"

● "Title Effects"
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6. If the sequence is parked within the effect, changes display immediately in the Sequence
viewer and on the output monitor.

7. Click on the green button to toggle the effect ON and OFF. The button displays green when
the effect is enabled.

8. To remove or reset an effect, click on the Cogs icon. From the menu that opens:

● Click Reset to revert all the settings to their default values.
● Click Remove to delete the effect from the timeline.

Color Effects
This chapter describes the use of color correction, selective correction, and color effects.

Color Tint
Tints the whole image in one color.

● Tint Color: To change the color from the default, click the color box and use the scales or the
dropper to create the required color.

● Amount: Increases or decreases the amount of tint.

Greyscale
Adjusts the greyscale within an image.

● Channel Weights: Lets you make colors lighter or darker by adjusting the Red, Green, Blue
scales within the effect.

● Channel Contrasts: Increases or decreases the amount of contrast by adjusting the Red,
Green, Blue scales.
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Negative
Changes the image color to a negative state.

● Level: Adjusts the level of the greyscale.

● Softness: Adjusts the hardness or softness of the image.

Two-Tone
Allows you to adapt two colors (dark and light).

● Threshold: The higher the percentage, the more the image takes on the color in the dark
color box.

● Dark Color

● Light Color

Tri-Tone
Allows you to adapt three colors (dark, mid, and light). The threshold features let you enhance the
chosen colors manually.

● Threshold One: The higher the percentage, the more the image takes on the color in the
dark color box.

● Threshold Two: The higher the percentage, the more the image takes on the color in the mid
color - the lower the percentage, the more it takes on the light color.
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● Dark Color

● Mid Color

● Light Color

Color Temperature
Adjusts the colors of the video to make them appear warmer or cooler.

Temperature: Move the slider to increase or decrease the color temperature of the video image.

Color Correction
Setting Tonal Ranges

The Main color tab displays by default when you select Color Correction. This section allows you to
adjust the following parameters:
Shadows - Controls color shades in the color spectrum using the tint hue, tint amount, and
brightness parameters.
Mid-tone - Controls the mid-tones you want in the spectrum.
Highlights - Modifies the brighter colors in the images

1. Click the arrow to alternately maximize and minimize the Color Correction panel.
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2. Click on the Main tab if not already selected.

3. Click on the Luminance icon to adjust the luminance for Shadows.

a. The Luminance edit panel opens.

b. Click on the graph line to add keyframes as required.

c. Drag each keyframe with the mouse to set the required response.

d. To delete a keyframe, select with the mouse and then click the Delete button.

4. Adjust the hue by dragging the marker on the respective color wheel.

Alternatively, type in the hue value and percentage directly into the text boxes below the
color wheel.

5. Adjust the brightness by dragging the slider to the required setting. Alternatively, adjust by
typing a value directly into the text box below the slider. The higher the gain, the more
distorted the image becomes as it takes on a grainy, pixelated quality.

6. Move the relevant slider let or right to decrease or increase Color Saturation, Gamma,
Contrast, Brightness, and Gain.

7. Repeat steps 3 to 6 for Midtones and Highlights.
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Color Balance

The Balance tab allows you to choose three colors to edit. The defaults are black, white, and gray.

1. Click on the Balance tab to select Color Balance.

2. Click the keyframe button to toggle enable or disable keyframes for the corresponding color.

3. Click the color palette to open the color palette for the corresponding color.

4. The color palette opens. Do one of the following:

● Drag the sliders marked Red (R), Green (G) and Blue (B) to select the color you require, or
type values directly into the R, G and B text boxes.

● Drag the pointer on the color wheel to the color you require.

● Type values directly into the H, S, V text boxes for the Hue, Saturation and Value levels
you require.

● Drag the Value slider to select the level you require.

5. Select in turn, the black, gray and white dropper tool, and drag onto the area on the screen
which is the same color as you want for your selection. This optimizes the color balance for
the recorded image.
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RGB Settings

The RGB tab adjusts red, green, and blue channels individually. Each of the options helps to create
different effects on the colors in the image: Gamma, contrast, brightness and gain.

1. Click on the RGB tab.

2. The RGB options display. If you cannot see all of the display, drag the top or bottom frame
edge to resize the dialog box, use the scroll bar to reveal the remaining screen content.

3. Adjust the Red, Green and Blue sliders as required for each parameter.

4. If you want to change the Red, Green and Blue values over time, that is, over the duration of
the clip, click the keyframe button to toggle keyframes ON or OFF for the corresponding
parameter. See "Keyframes" for further information about using keyframes.
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HSV Settings

This tab adjusts the Hue, Saturation and Value (HSV) settings.

1. Click on the HSV tab.

2. Adjust the Hue, Saturation and Value sliders as required for each parameter.

3. If you want to change the Hue, Saturation and Values over time, that is, over the duration of
the clip, click the keyframe button to toggle keyframes ON or OFF for the corresponding
parameter. See "Keyframes" for further information about using keyframes.
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Curves

The Curves tab allows you to set keyframes for RGB and Luminance profiles.

1. To display the Curves parameter options, click the Curves tab.

2. To change the parameter values over time, that is, over the duration of the clip, click the
keyframe button to toggle keyframes ON or OFF for the corresponding parameter.

3. Click on the graph line to add keyframes as required. Drag each keyframe with the mouse to
set the required response. See "Keyframes" for further information about using keyframes.
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Selective Correction
Selective correction is similar to Color Correction but allows you to change up to four different colors
at once.

Make changes to Balance, Tonal Ranges, RGB, HSV and Curves, as described in "Color Correction".

3D LUT
Applies a Look Up Table (LUT) effect to the image.

● LUT: Select the LUT effect you require from the drop down list.

● Amount: Use the slider to adjust the level of the effect.
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Digital Video Effects (DVE)
The DVE category contains a range of picture effects, all of which derive from the basic
Picture-in-Picture and DVE effects. To add a second picture to these effects, you need to add a
second video track to the timeline.

2D DVE
The 2D DVE effect allows you to move the image in any position you want.

1. Click on the Position menu to expand its contents.

● Drag slider X to position the image horizontally on the screen.
● Drag slider Y to position the image vertically on the screen.

2. Click on the Scale menu to expand its contents.

● Drag the Master slider to resize the image.
● Drag slider X to stretch or squeeze the image horizontally.
● Drag slider Z to stretch or squeeze the image vertically.

3. Click on the on the Crop menu to expand its contents. Drag the named sliders to crop the
Left, Right, Top and Bottom sides of the image.

4. Click on the Shadow menu to expand its contents.

● Drag the Transparency slider to change the transparency of the shadow.
● Drag the X Offset slider Y to offset the shadow horizontally.
● Drag the Y-Offset slider Z to offset the shadow vertically.

5. Drag the Edge Softness slider left or right to adjust the sharpness or softness of the image edge.

6. Drag the Opacity slider left or right to change the opacity of the image.
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3D DVE
The 3D DVE effect allows you to move the image in any position you want.

1. Click on the Rotation menu to expand its contents.

● Using your mouse, rotate the X clock face control to rotate the image round the
horizontal axis.

● Rotate the Y clock face control to rotate the image round the vertical axis.

● Rotate the Z clock face control to rotate the screen image.

The text box immediately to the left of each clock displays the amount of rotation in degrees.
You can also type a value directly into the box to set the rotation.

2. Click on the Position menu to expand its contents.

● Drag slider X to position the image horizontally on the screen.

● Drag slider Y to position the image vertically on the screen.

● Drag slider Z to resize the image.

3. Click on the Pivot menu to expand its contents.

● Drag slider X to move the image horizontally on the screen.

● Drag slider Y to move the image vertically on the screen.
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4. Click on the on the Crop menu to expand its contents. Drag the named sliders to crop the
Left, Right, Top and Bottom sides of the image.

5. Click on the Shadow menu to expand its contents.

● Drag the Distance slider to change the size of the shadow.

● Drag the X Offset slider Y to offset the shadow horizontally.

● Drag the Y-Offset slider Z to offset the shadow vertically.

6. Drag the Edge Softness slider left or right to adjust the sharpness or softness of the image edge.

7. Drag the Opacity slider left or right to change the opacity of the image.

Cine Crop 1
The Cine Crop 1 effect allows you to move the image in any position you want. The adjustments are
the same as described in "2D DVE".

Flip and Flop
The Flip feature flips the screen image on the horizontal axis, while the Flop feature flips the screen
image on the vertical axis.

There are no settings for either of these features.

Picture In Picture Presets
The following Picture in Picture options have the same controls as described in "3D DVE". The
following presets are available:

Angle Left Angle Right (pictured)

Bottom Left Bottom Center Bottom Right

Mid left Mid Center Mid Right

Top Left Top Center Top Right
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Split Screen
Displays two images side by side (FLOW Story is restricted to two video tracks).

1. From the DVE settings menu, select Split Screen.

2. Drag and drop the effect to the timeline.

3. Under Right Picture, click on the Position menu to expand its contents.

● Drag slider X to position the image horizontally on the screen.

● Drag slider Y to position the image vertically on the screen.

4. Click on the Scale menu to expand its contents.

● Drag the Master slider to resize the image.

● Drag slider X to stretch or squeeze the image horizontally.

5. Click on the on the Crop menu to expand its contents. Drag the named sliders to crop the
Left, Right, Top and Bottom sides of the image.

6. Click on the Shadow menu to expand its contents.
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● Drag the Transparency slider to change the transparency of the shadow.

● Drag the X Offset slider Y to offset the shadow horizontally.

● Drag the Y-Offset slider Z to offset the shadow vertically.

7. Drag the Opacity slider left or right to change the opacity of the image.

8. Repeat the previous steps for the Left Picture.

Split Screen with Background (+bg)
This option is the same as Split Screen, but with the option to set a two-color background.

1. From the DVE settings menu, select Split Screen + bg.

2. Drag and drop the effect to the timeline.

3. Under background, click on the Color One menu to expand its contents.

● Select the color you require by clicking on the color palette tab or by using the color picker.
● Drag the Extent slider to adjust the level of the first color.

4. Repeat step 2 for Color Two. Note: Make sure the luminance level is not set to 0%, otherwise
you will not be able to see the color change.

166



Key Effects
Chromakey
Layers two images or video streams together based on color hues (chroma range).

1. Click on the eyedropper tool, drag it on to a point on the screen that is the same color you
want to change, and click again to select the color.

2. When you hover your mouse over the Hue, Saturation or Luminance bar, the mouse cursor
changes to a double-arrow. This lets you drag the selected bar left or right to adjust its setting.

3. Any changes you make to Hue, Saturation and Luminance display in the Viewer.

4. Tick the Reveal box to display which on-screen elements you have selected.

5. Tick the Invert box to display which on-screen elements have not been selected.
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Lumakey
Sets the brightness level, so that all of the brighter or darker pixels from the image are turned off,
making them transparent. The image or video behind the top layer show through the transparent
sections.

1. Drag the Tolerance slider left or right to adjust the brightness or transparency. Alternatively,
type a percentage value into the text box to the right of the slider.

2. Drag the Edge softness slider left or right to sharpen or soften the image edges.
Alternatively, enter a percentage value into the text box to the right of the slider.

3. Select the Invert box to invert the screen colors.
4. Any changes you make to the settings display in the Viewer.

Color Mask
NOTE: To apply a color mask, you must already have an effect added to the timeline.

Takes any color you selected and applies changes you make to Hue, Saturation and Luminance to all
instances of that color in the viewer. You can connect other effects and apply them to the regions
that match that color. For example, to blur only the green areas of an image, you apply the color
mask, choose green, and then apply a blur effect.

1. Right click on the effect that you want to apply the mask to on the timeline and under the
Effects heading, select Add - color Mask.
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2. Click on the eyedropper tool, drag it on to a point on the screen that is the same color you
want to change, and click again to select the color.

3. When you hover your mouse over the Hue, Saturation or Luminance bar, the mouse cursor
changes to a double-arrow. You can now drag the selected bar left or right to adjust its setting.

4. Any changes you make to Hue, Saturation and Luminance display in the Viewer.

5. Select the Reveal box to display which on-screen elements you have selected.

6. Select the Invert box to display which on-screen elements have not been selected.

Image Key
Lets you insert an image into the frame on top of the other image, which allows images to run
alongside each other and lets you place inserts where you want them.

Bluescreen and Greenscreen
When you add either of these effects, the Chromakey dialog box opens. Removes color from the
front image to reveal the image underneath.

Matte Effects
Color Bars
Adds vertical color bars.

Standard: Select 75% or 100% brightness.

Color Matte
Places a color over the top of the image.

Color: Select the overlay color from the Color Palette or Color Picker tools.
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Color Gradient
Places a color gradient over the underlying image.

● Type: Select the gradient type from the drop down list.

● Color One/Color Two: Select colors for color one and color two.

● Color: Select the overlay color from the Color Palette or Color Picker tools.

● Extent: Drag the slider to regulate color extent. The smaller the extent, the more the image
underneath shows through.

Corner Gradient
Creates a color matte with a gradient to and from each corner.

● Colors: Select the overlay color for each corner from the Color Palette or Color Picker tools.

● Bounds: Drag the slider to adjust the offset of each edge from the image frame.
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Simple 2D Shape
Creates a rectangular or oval shape with foreground and background colors.

Shape: Select Rectangle or Ellipse from the drop down list.

Use the sliders to set:

● Position: X (horizontal) and Y (vertical) positions
● Width
● Height
● Softness
● Foreground
● Background

Image
Places a user defined image over the screen.

● Image: Click on the triangle to open a file manager. Navigate to, and select the image you
want to use.

● Position: Select the X, Y coordinates of the image.
● Scale: Set the linear scale (Master) or set X and Y scales separately.
● Crop: Use the sliders to crop left, right, top and bottom edges of the image.
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Mix Effects
See the descriptions for Blend, Dissolve, Wipe, and Luna Wipe in "Chapter 9: Transitions".

Stylize Effects
Blur
Creates a blur on an image. There is only one control, a slider you move left or right to decrease or
increase the level of blur on the image.

Glow
Enhances the brighter colors and gives the image a glow-like quality.

● Source - Select the light source for the glow - Luminance, Red, Green or Blue

● Tolerance- Slide to decrease or increase the threshold of the glow effect

● Feather - Set the distance over which the glow source fades to dark

● Size - Slide to decrease or increase the size of the glow effect

● Strength - Slide to decrease or increase the strength of the glow effect

● Color - Use the color palette or color picker to set the glow color

Mosiac
Enlarges the pixels and turns them into larger squares to create a mosaic effect. There is only one
control, a slider you move left or right to decrease or increase the level of pixelation.

Posterize
Converts the image to several regions of fewer tones, with abrupt changes from one tone to
another, creating a pop-art poster style. There is only one control, a slider you move left or right to
decrease or increase the level of posterization.

Radial Blur
Creates a blur in a set position within the frame. There are two sliders X and Y, which provide
horizontal and vertical offsets for the blur.
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Sharpen
Sharpens the edges of the picture and any fine lines within the frame. There is only one control, a
slider you move left or right to decrease or increase the level of sharpness. Setting to maximum
sharpness may result in graining of some image areas.

Sharpen Edges
Sharpens the edges within the frame as well as the frame itself. There are three sliders:

● Radius - slide left or right to decrease or increase the size of edges you want to sharpen
● Strength - slide left or right to decrease or increase the strength of the sharpening effect
● Threshold - slide left or right to decrease or increase the minimum brightness change that is

sharpened.

Title Effects
There are three types of Title Effects:

● Crawling Titles - Titles that crawl horizontally across the screen.
● Rolling Titles - Titles that roll down or up the screen.
● Static Titles - Static titles that are in a fixed position on screen.

Setting Title Text and Font Properties
To set the font, size and positioning of your title or caption:

1. Make sure the VFX tab is selected.
2. Click the arrow next to the Titles category to expand the heading.

3. Enter the title or caption text you require in the upper panel.
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You can enter multiple lines of text to:
● Display multi-line text in Static and Rolling Titles.
● Display separate messages or headlines that scroll horizontally in Crawling Titles.

4. Any changes you make to the text display in the viewer in real time.
5. Click on the Font tab if it is not already selected.
6. Select the font you want from the Typeface drop down list. The fonts listed are those

installed on your workstation.
7. To select Bold and/or Italics styling, tick the named boxes.
8. Drag the Size slider left or right to resize the text as required.
9. Drag the Opacity slider left or right to adjust the opacity / transparency of the displayed text.

Setting Title Text Color
To set the color properties of your title text:

1. Click the Face tab to access the settings for the title color.
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2. Select the color style you require by clicking one of the following options:

Flat Color - Set a single color for your text

Vertical Gradient - Set a vertical gradient based on two colors

Sheen - Create a reflective or sheen effect using two colors

If you select Flat Color, only one color setting is available - Color Two is disabled.

3. Click the box for Color One to open the Color palette.

a. The color selector dialog box opens.

b. Select the color you require using the RGB sliders, the color wheel, or the HSV text boxes
and slider.

4. Alternatively, click on the color picker and drag the mouse onto the section of screen that
matches the color you want. Click again to select the color.

5. Repeat steps 3 and 4 for the second color, using the color box or picker for Color Two.

Setting Title Position and Movement
To set the screen position of your title text:

1. Click the Position tab to access the settings for the title text positioning.
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2. Static Titles only: Click the Position tab to reveal the controls for vertical (X), horizontal (Y)
text offset.

3. Static Titles only: Adjust the X and Y sliders to set the required vertical and horizontal
positions for your title. Alternatively, type a percentage value in the text field to the right of
the sliders.

4. Rolling and Crawling Titles only: Adjust the Position and Progress sliders to set the required
starting positions of titles. Alternatively, type a percentage value in the text field to the right
of the sliders.

5. Static and Rolling Titles only: Adjust the Leading slider to set the line spacing for titles that span
across two lines or more, or type a percentage value in the text field to the right of the slider.

6. Static and Rolling Titles only: Set the alignment for your title from the Anchor point drop
down list. The options are Left, Center and Right.

7. Crawling Titles only: Adjust the Spacing slider to set the horizontal spacing between
messages, or type a percentage value in the text field to the right of the slider.

Title Shadow
To set properties for shadows on titles:

1. Click the Shadow tab.

2. To enable the shadow effect, tick the Enabled box.

3. To set the shadow color:

a. Click the Color box.
b. The color selector dialog box opens.
c. Select the color you require using the RGB sliders, the color wheel, or the HSV text boxes

and slider.
d. Alternatively, click on the color picker and drag the mouse onto the section of screen

that matches the color you want. Click again to select the color.
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4. Slide the vertical offset (X) to set the required vertical position for your shadow. Alternatively,
type a percentage value in the text field to the right of the slider.

5. Slide the horizontal offset (Y) to set the required horizontal position for your shadow.
Alternatively, type a percentage value in the text field to the right of the slider.

6. Adjust the Softness slider left or right to set the sharpness (left) or softness level (right) of
your shadow. Alternatively, type a percentage value in the text field to the right of the slider.

Title Text Outline
To set the Outline properties for your titles:

1. Click the Outline tab.

2. To enable outlining on your title text, tick the Enabled box.

3. To set the outline color:

a. Click the Color box.
b. The color selector dialog box opens.
c. Select the color you require using the RGB sliders, the color wheel, or the HSV text boxes

and slider.
d. Alternatively, click on the color picker and drag the mouse onto the section of screen

that matches the color you want. Click again to select the color.

4. Adjust the Size slider left or right to set the size (thickness) of the outline. Alternatively, type a
percentage value in the text field to the right of the slider.
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Effects (Static Titles only)
The Effects tab allows you to set how your title starts and ends. Rolling and Crawling Titles do not
have an Effect tab.

1. Click the Effects tab.

2. From the In drop down list, select how you want the title to start. The options are:

● No effect

● Fade (text fades in)

● Typewriter (text appears one character at a time)

3. From the Out drop down list, select how you want the title to end. The options are:

● No effect

● Fade (text fades out)
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Look Up Tables
Look Up Table (LUT) files allow you to apply professional looking color grading to your media using
just a single LUT file. You can also import LUT files from most color grading applications.

Due to Licensing restrictions, a single LUT file is supplied. However, many more LUT files are
available on the internet for download, either free or for a nominal charge.

Applying a Global LUT
You can set a global LUT for your project in the Project Card. All the clips and edits in your project
will have the same LUT applied to them. Global LUT settings are best used with footage shot from
the same camera to maintain a consistent look.

1. Open the Project Card and click on the Video tab.

2. Click on the pointer for the Viewing LUT drop down list.

3. A list of available LUTs opens. Click to select the LUT you require.

4. The Viewing LUT button changes to green, indicating that the currently selected Global LUT is active.

5. To change the Global LUT, repeat steps 1 to 3.

6. To disable Global LUTs, click the Viewing LUT button again. The button changes to grey.
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Importing LUT Files from the Project Card
The following LUT file formats are supported: 3dl, cube, davlut, look, and mga file formats. To
import LUT files:

1. Open the Project Card, click on the Video tab (A), click the Output heading the drop down list
pointer (B) and then click Browse (C).

2. The File Manager opens. Navigate to the folder where your LUT files are stored.
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3. Click on a single file to select it, or hold down the Shift or Ctrl (Cmd on OS X) key to select
multiple files. You can also select folder icons.

4. Click OK. The selected LUT files are added to the dropdown list, and are available in the
Global LUT and Single source LUT lists.

Importing LUT Files from the Timeline
To import LUT files from the Timeline:

1. Select the VFX tab, right-click in a video track and, from the menu that opens, select Effects >
Add > Color > 3D LUT.

2. When the 3D LUT effect panel opens, click on the drop down menu.

3. A list of LUT items displays.

4. Click the Browse button.
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5. The File Manager opens. Navigate to the folder where your LUT files are stored.

6. Click on a single file to select it, or hold down the Shift or Ctrl (Cmd on OS X) key to select
multiple files. You can also select folder icons.

7. Click OK. The selected LUT files are added to the dropdown list, and are available in the
Global LUT and Single source LUT lists.
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Keyframes
About Keyframes
Most effect parameters are keyframeable. Keyframes allow you to specify the value for an effect
parameter at any point in time within an effect. This allows properties of the effect to be varied as
the effect progresses through time. The system by default interpolates between the values set at
each keyframe, resulting in a smooth transition between adjacent key frames.

Note: The keyframe buttons for most parameters are deselected by default. In this mode, adjustments to a
parameter are applied for the duration of the effect.

The Progress parameter is present on all effect configuration dialog boxes. You can use the Progress
slider to control the progress of an effect through time. For example, it sets the position of a wipe at
a particular time. Unlike other parameters, progress for most effects defaults to being
Keyframeable. Initially, it has two Keyframes:

● One at the start of the effect where its value is 0%

● One at the end where its value is 100%

By adding keyframes to the Progress parameter, the effect can be made to assume different
positions at different times. For example, the wipe can be made to stop, reverse and then continue
to the end. As with other parameters, keyframes for Progress can be turned off. In this case, the
effect assumes the value set on the progress slider for the duration of the effect. In this state the
effect is static. This is useful for creating a static wipe, for example.
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Working with Keyframes
The following example shows how keyframes are added and adjusted in the Wipe effect:

1. Click on the Graphs heading at the top of the Configuration dialog box.

2. When the Graph view is open, hover your mouse over the area with the gradient. All the
keyframes display within the current effect, showing how their values vary over time.

3. A timeline indicator displays the current playing position within the effect.

4. To add a keyframe:

a. Move the timeline marker to the required position on the timeline.

b. Click the Add (+) button in the keyframes area.

5. Each keyframe has a marker on the graph line. To select a keyframe:

a. Hover the mouse over the keyframe marker.

b. When the mouse cursor changes to a cross, click to select the keyframe. To select
multiple keyframes, press Ctrl+click (Ctrl+Cmd for Mac OS) on the required keyframes.
To select all keyframes, right-click on a keyframe and then click Select all.

6. To jump to a keyframe, click the Previous (<) or Next (>) button. Alternatively, assign
keyboard shortcuts to do this.

7. To remove the selected keyframe, click the Remove (-) button.
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Adjusting Keyframes
To adjust the value and position of keyframes:

1. To change the value of a keyframe, click the keyframe and drag it vertically to the value you want.

2. The effect at the current time updates in the Edit viewer and in the Keyframes area.

3. To change the position of a keyframe, click the keyframe and drag it horizontally to the
position you want.

To move multiple keyframes, do one of the following:

● Ctrl+click (Ctrl+Cmd on Mac) on the keyframes you want and then drag them as a group.

● Hold down the left mouse button and draw a rectangle around the keyframes you want
to select.

● To select all keyframes, right-click on a keyframe and then click Select all.

4. To toggle the effect ON or OFF, click the Toggle Bypass button.

5. (Optional) Change the type of interpolation by clicking anywhere in the dialog box and
holding down the SHIFT key. The type of interpolation toggles between:

● Smooth

● Linear

6. To toggle the interpolation between two keyframes only, click anywhere in the dialog box
while holding down the Ctrl key (Cmd key on Mac).
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Saving Effects Templates
You can save an Effect and its parameters in a template for use later without recreating the effect
from scratch.

1. Right-click outside an effect on the effects panel.

2. From the menu that opens select Save as template.

3. The Template dialog box opens.

4. Type a name for your effect. Choose a name that best explains what the saved effect will do.

5. Select a Category type from the drop down list.

6. Select a Subcategory type from the drop down list.

7. Tick the Add to favorites box if you want the newly saved effect to display in the Favorites
area of your effects list. This is useful if you use the effect frequently, allowing it to be
accessed quickly from contextual menus.

8. Add a description in the text box that will help you to remember the details of what the
saved effect achieves.

9. Click Save.

10. Your template is saved to the Add Effects list box. If you ticked the Add to favorites box, the
template displays when you select Favorites from the Category drop down list.
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Chapter 11: Video Routing Panel
The Video Routing Panel is designed to manage your multi-track effects compositions. For example, if
you have two clips open and you want to add a separate effect to each one. It is a node based system
allowing you to build up blocks and set the FLOW of your effects through each stage of your project.

Using the Video Routing Panel
To use the Video Routing Panel, you must have the Edit and Timeline viewers for your project open.

1. Make sure you have the VFX tab selected.

2. Click on the Routing tab. The Video Routing panel displays.

3. The nodes and blocks display in the main panel.

4. To change the direction of FLOW of the nodes, right-click in the panel and, from the menu
that opens, select Orientation > ‘Left to right’ or Orientation > ‘Bottom to top’.
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5. To readjust the nodes in the main panel, right-click in the panel and, from the menu that
opens, select Tidy.

6. Use the horizontal (A) and vertical (B) scroll bars to move the Video Routing panel to reveal
Nodes that are beyond the edges of the panel frame.

7. To zoom in and out, hover your mouse over the edge of a scroll bar until the cursor changes
to a double-ended arrow, then click and drag to zoom.

Working with Nodes
You can manage nodes as follows:

1. Each node displays a thumbnail of the original clip.

2. The name of the original clip displays in the title bar.

3. To delete an effect node, right-click on the node and, from the menu that opens, select Remove.

4. While holding down the left button anywhere in the panel, drag your mouse to position all
the nodes on the display at once.

5. To move effect node pairs, for example the split screen node pairs:

a. Click drag with the mouse to move one node independently of the other.

b. Hold down the shift key while click dragging to move both nodes at once.

6. To swap inputs on a node, right-click on the node and, from the menu that opens, select
‘Cycle inputs’.
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Adding a Basic Effect
Adding an Effect to a Node
The procedure described below describes adding a blur effect to a Node. This procedure is the same
for most effects, although the settings for each effect vary significantly.

The Blur effect can be applied to text as well as graphics.

1. Select the VFX tab and then select the Stylize menu.

2. Using the mouse, drag the Blur effect over the Routing tab.

3. When the Video Routing panel opens, release the mouse button to drop the Blur node into
the middle of the panel.

4. Drag the mouse to create a link from the output of the first node to the input of the Blur effect.

5. Do one of the following:

● Right-click on the Blur node and, from the menu that opens, select Settings.

● Click on the Settings tab.

6. The Blur Settings dialog box opens.

7. Move the slider to the left to decrease the amount of blur, or to the right to increase blur.

Changes you make are updated immediately in the clip viewer.
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Swapping an Effect
You can change out one Effect for another in one operation without deleting the old effect first:

1. Select the new Effect and drag it over the Routing tab.
2. When the Video Routing panel opens, position the new node onto the node you want to

replace, and then tap the right mouse button to ‘drop’ in the new Effect.
3. The old Effect is removed and is replaced by the new Effect. All the connections are maintained.

Creating a Split Screen
Creating a Split Screen Effect
To add a Split Screen effect:

1. Make sure you have two video tracks enabled in the Sequence viewer, populated with the
clips you want in your Split Screen effect.

2. Click the plus + icon next to the settings heading.
3. Select the DVE menu.
4. Scroll down and select the Split Screen effect.
5. Hold down your mouse button and drag the effect over to the Routing tab.
6. When the Video Routing panel opens, release the mouse button to drop the Split Screen

node into the middle of the panel.
7. The Left Picture and Right Picture nodes pair display in the Video Routing panel.
8. Drag the mouse to link the connector of the first node to the Foreground (Fg) connector of

the Right Picture node.
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9. Drag the mouse to link the connector of the second node to the Foreground (Fg) connector
of the Left Picture node.

10. Do one of the following:

● Right-click on the Left Picture or Right Picture node and, from the menu that opens,
select Settings.

● Click on the Settings tab.

11. The Settings panel opens.

12. If the clips do not display side by side in the Sequence Viewer, make sure the Left and Right
Picture effects are enabled, that is, both indicators are green.

Adding a Color Tint
To add a color tint to a node:

1. From the Effects drop down list, select color.
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2. The Color options display in the main panel. Click on the color affect you want and drag it on
to the Routing tab.

3. When the Video Routing panel opens, position the effect over the clip you want to apply the
effect to, and release the mouse button.

4. The tint node is inserted between the clip and the Picture node.
5. The color tint displays on the affected clip in the Edit viewer.
6. Do one of the following:

● Right-click on the tint node and, from the menu that opens, select Settings.
● Click on the Settings tab.

7. When the Settings panel opens, make any changes you want to the effect, as described in
"Chapter 10: Effects".

Creating a Split Screen Effect with Background
You can add a background image to the Split Screen effect as follows:

1. Make sure you have two video tracks enabled in the Sequence viewer, populated with the
clips you want in your Split Screen effect.

2. From the DVE menu, drag the ‘Split Screen+bg’ effect with your mouse over the Routing tab.
3. When the Video Routing panel opens, release the mouse button to drop the ‘Split Screen+bg’

node into the panel.

4. The Left Picture, Right Picture and Background nodes display in the Video Routing panel.
5. Drag the mouse to link the connector of the first node to the Foreground (Fg) connector of

the Right Picture node.
6. Drag the mouse to link the connector of the second node to the Foreground (Fg) connector

of the Left Picture node.
7. The Sequence viewer displays the background image behind the two Split Screen images.
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8. Do one of the following:
● Right-click on the Background node and, from the menu that opens, select Settings.
● Click on the Settings tab.

9. The Settings panel displays.
10. Edit the Background node settings as described in the "Split Screen with Background (+bg)" section.

Adding Titles
To add a title to your project, you must add a Titles Effect and feed it with your video output to a
Blend Option:

1. Click the plus + icon next to the settings heading.

2. From the Categories drop down list, select Mix. The Mix options display in the panel. Click on
the mix you require, for example, Blend, and drag it on to the Routing tab.

3. When the Video Routing panel opens, position the Blend effect inside the Video Routing
panel and release the mouse button.

4. From the Categories drop down list, select Text. The Titles options display in the panel.
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5. Click on the title affect you want and drag it on to the Routing tab.

6. When the Video Routing panel opens, position the selected effect inside the Video Routing
panel and release the mouse button.

7. Connect the output of the Titles node to the Foreground (Fg) input of the Blend Effect.

8. Connect the output of the Right Picture node to the Background (Bg) input of the Blend
Effect. The default caption ‘Sample text’ displays in your edit.

9. To change the appearance or blending of the title text, right-click the Titles or Blend nodes
and, from the menu that opens, select Settings. The Effects panel opens.

Adding a Wipe Transition
In this example we are transitioning from the Split Screen effect to a single screen using the Wipe effect.

1. From the Categories drop down list, select Mix. The Mix options display in the panel. Click on
Wipe and drag it onto the Routing tab.

2. When the Video Routing panel opens, position the Wipe effect inside the panel and release
the mouse button.

3. Connect the output from your project to one input of the Wipe effect.
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4. On the node you want to transition to, connect its output to the other input of the Wipe
effect. In this example we are reusing a node from the Split Screen example.

5. Play the project and check that the video wipes from the first clip to the second clip in the
correct sequence. To change the playing order, right-click on the Wipe node and select ‘Cycle
inputs’ from the menu.

6. Click on the Graphs tab. When the Keyframes panel for the effect opens, click on the graph icon.

7. The Keyframes panel displays.

8. Adjust the Progress line to change the rate at which the wipe changes. See "Adjusting
Keyframes".

9. Click on the Settings tab to open the Wipe settings dialog box. Adjust the wipe settings as
described in.
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Chapter 12: Multicam Editing
This chapter describes the methods for editing with multiple camera file groups.  The files can be
synchronized via audio waveform, current frame or timecode.

Image Credit: Media kindly provided for reproduction by Blackmagic Design Ltd

Creating a Multicam bin
To create a Multicam bin:

1. Import clips from storage into a project.
2. Select the target clips  either by lasso, shift or ctrl/cmd clicking in the bin
3. Right-click Make / Multicam bin.

4. Name the new bin as required.

5. Choose from the options to sync the clips:
a. Current frame - the parked position under the  source clip CTI will be used as the

sync point ( e.g. slate/clap/flash frame)
b. Audio waveform - audio track  waveform will be analysed and  aligned
c. Timecode
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6. Press ‘Create’, the new multicam group will appear as a new object in the projects bin list
display

Viewing a Multicam bin in Sync Mode

Toggle the view icon
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View options:

Number of …

Resynchronise Clips

198



Adding markers
Enable mark across all clips.

Auto sync with record sequence

Creating a Multicam Group Bin
To create a Multicam bin:

7. Import clips from storage into a project.
8. Select the target clips  either by lasso, shift or ctrl/cmd clicking in the bin
9. Right-click Make / Multicam bin.
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10. Name the new bin as required.

11. Choose from the options to sync the clips:
a. Current frame - the parked position under the  source clip CTI will be used as the

sync point ( e.g. slate/clap/flash frame)
b. Audio waveform - audio track  waveform will be analysed and  aligned
c. Timecode

12. Press ‘Create’, the new multicam group will appear as a new object in the projects bin list
display

Viewing a Multicam bin in Sync Mode

Toggle the view icon
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View options:

Number of …
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Resynchronise Clips

Adding markers
Enable mark across all clips.

Auto sync with record sequence
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Chapter 13: Importing
This chapter describes the methods for importing media, supported file types and formats.

You can import media from your local folders and network drives. The media you import should
have a frame rate that is compatible with your project. (Clips with incompatible frame rates may be
playable in a new project set to the same frame rate as that clip.)

Supported Import Formats
FLOW Story supports the same codecs as other applications in the FLOW suite. Refer to the FLOW
Supported Formats User’s Reference for detailed information.

Importing Clips into a Project
See the topic “Import Destinations”.

Importing Clips from Storage Spaces
See the topic “Importing Clips from Storage Spaces”.

Import Destinations
In order to import media to your project, you must have a media drive to hold all the relevant data.
By default, FLOW Story creates and uses the following locations for all media imports:

Windows - C:\Users\Public\Documents\Flow Story\Media

Mac OS X - /Users/USER ACCOUNT/Flow Story/Media

If you do not want to use the destination folder set by FLOW Story, or you want to organize your
media imports into separate folders, you can create alternative destination folders and choose
which one you want to use when you import media.

The Content Manager opens to reveal newly imported media in the Recent or Search Filter, a user
defined option.
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Creating an Import Destination

To create an alternative import destination:

1. Open the project card and select the Media tab.

2. Click the Locations heading.
3. Click the Add button.
4. The Add Folder Location browser opens.
5. Navigate to the location you want to use. If you need to create a sub folder, click the ‘Create

New folder’ button and type the folder name and click OK.
6. When you have selected your new destination folder, click the OK button. A Material and

Sound folder is created in the specified location. The new destination displays in the Media
tab of the project card.
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Removing an Import Destination
When you remove an import destination, you will no longer be able to see media files stored in that
location. However, the media stored at those locations will not be deleted, nor will any logs
referenced to it. If you add a location that was previously deleted, any media in that location will be
available to use again.

To remove an import destination:

1. Open the project card and select the Media tab.
2. Click the media location to select it for deletion.
3. Click the Remove button. A message box displays, warning you that you are about to remove

a media location.
4. Click Yes to remove the entry from the Project card, or No to cancel.

Selecting an Import Destination
To change the Import destination on import:

1. Right-click on a clip or clips that you are importing.

2. The Import Commands dialog box opens.
3. Optional: Select the size of the thumbnails that will be used to display the media, for

example Extra large.
4. Select Destination > Media Location.
5. From the menu that opens, select the media location you require. If you select Auto, FLOW

Story chooses the location with the most free space available.
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RED (R3D) Files
You can import RED files into FLOW Story. See the following topics:

About RED Files
You can import RED R3D natively. You can choose full resolution or one of the standard reduced
resolution modes (½, ¼) to change the decode quality of the imported R3D file. Currently R3D files
with aspect ratios of 4:3 or 16:9 are supported. No R3D export is available.

There are some performance considerations when you use RED R3D files with FLOW Story.
Depending on the workflow and formats required, older workstations might require a hardware
upgrade.

Note: Working natively with sequences of R3D files is very demanding on disk storage, CPU, and graphics
card performance, particularly at higher resolutions.

Importing R3D Files
To import R3D files:

1. Select the R3D file or files you want to import and click the Import button.
2. The file imports. Click on the Project name at the top-left corner of the workspace.
3. The Project panel opens. Click on the Video tab if it is not selected.

4. Click on the drop down list to the right of the RED decode quality field, and select the
required resolution from the list.

5. The R3D file opens and plays in the resolution you selected.
6. If your workstation performance allows it, you can select a higher resolution when the edit is

ready for playout.
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Audio Files in 30 fps and 24 fps Projects
You can change the frame rate on an audio file. By default in a 24fps project a frame rate of the
audio file is set to 24fps, but it may playback at the incorrect speed (slower or faster) depending on
the output format on the project card. If you experience an issue with an audio only file playing back
at the wrong speed, you should change the frame rate of the file to the correct or expected frame
rate that you are editing at.

1. Import the Audio file.
2. Change the frame rate in the List view bin or on the Metadata tab on the Browse tab.
3. Proceed to import your files as described in the previous sections.
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Chapter 14: Online Resources
Note: You must have an Internet connection to use Audio Network.

You can browse the following online libraries and resources using FLOW Story:

● "Audio Network"
● "Pond5"

Audio Network
Audio Network is a global music group company which has commissioned and recorded over
100,000 music tracks for use by television, film and multimedia corporations.

You can browse the entire selection of Audio Network music directly from within FLOW Story, import
audio files directly into the project and add to sequences, add search criteria that best suits your
requirements, then register or sign in to purchase directly.
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Searching for Music Tracks
To search for music tracks:

1. Click on the Log or Edit tab and then on the Audio Network heading under libraries.

2. Type your search criteria, for example, artist, title, music style, into the text box and click Search.
3. Music tracks matching your search input display. Artist, download price and descriptions

display against each track.
4. Use the side scroll bar and buttons at the bottom to page through longer track lists.
5. Left click on a clip which will give the clip focus for you to playback. You can now listen to a

preview, or use the playback shortcut keys.
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Importing Audio Network Clips
You can import Audio Network clips, add them to a sequence, and then publish this sequence.

1. Make sure the Edit tab is selected.
2. Click the Audio Network heading under Libraries.
3. Search for the types of audio files that you want (see previous task).

4. Select the files that you want to import.
5. Click the Import button.
6. The files are imported into your system.
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Purchasing Audio Network Media
Before proceeding to the checkout, you can review your selection in the shopping cart.

Although the files have been imported and added to a sequence, you cannot publish the sequence
until the tracks are paid for.

1. The shopping cart displays the music tracks you have selected for purchase. Artist, download
price and descriptions display against each track in the same format as in "Searching for
Music Tracks".

2. Double-click on a track to preview it, or use the Playback shortcut keys.
3. If you want to return to the store to review other items, click on the Library tab.
4. When you are satisfied with your selected purchases and want to proceed to the checkout,

click the Checkout button.
5. The Sign In dialog box opens. Type your Audio Network username and password, and then

click Sign In.
6. If you do not have an account, create one by clicking the Register tab and completing the

form presented to you.
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Setting Audio Network Account Options
To change the settings for your Audio Network account:

1. Right-click in the Audio Network area of the screen.
2. The Audio Network dialog box opens.

3. Select how you intend to use downloaded media (Professional, Television, Commercial) from
the Usage drop down list. Prices vary according to how the media will be used. For further
information, go to www.audionetwork.com.

4. Select the currency you want to use from the Currency drop down list. On-screen prices are
converted to the currency you selected.

Registering an Audio Network Account

To purchase audio tracks, you must register an Audio Network account.

1. Right-click in the Audio Network area of the screen.
2. The Audio Network dialog box opens.

3. Select Sign In.
4. Click the Register tab.
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5. Enter your details.
6. Click Register.

Signing In to Audio Network

When you have registered an Audio Network account, you can sign in using these credentials.

1. Right-click in the Audio Network area of the screen.
2. The Audio Network dialog box opens.

3. Click Sign In.

4.
5. Enter your email address and password.
6. Click Sign In.
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Changing the Waveform Thumbnail Size
To change the size of the Waveform thumbnails:

1. Right-click in the Audio Network area of the screen. The Import Command dialog box opens.
2. Under Appearance, select Small, Medium, Large or Extra Large from the Appearance drop

down list.

Pond5
NOTE: You must have an Internet connection to use Pond5.

You can browse, purchase and download royalty-free videos from Pond5, from within your FLOW
Story projects. Pond5 has reputedly the world's largest collection of royalty-free stock footage.

Searching for Video Clips
To search for video clips:

1. Click on the Browse or Edit tab
2. Click on Pond5 under the Libraries heading in the content manager.

3. Type your search criteria, for example, keywords, video format, into the text box and click Search.
4. Video tracks matching your search input display, together with description, video format,

frame rate and price.
5. Use the side scroll bar and number buttons to look through longer media lists.
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6. Click on a clip to select it.
7. Drag the scrub bar with your mouse to play through the clip, or use the playback shortcut keys.
8. Double-click on a track to play a larger preview in the media player.
9. Pond5 clips carry a watermark until you have purchased them.
10. Click Import to import a copy of the file to your local machine.

Search Options
You can refine your searches to include maximum price, video size and minimum clip length.

1. Right-click anywhere in the Pond5 panel. The Import Commands menu opens:

2. To set a maximum price for each item, select Pond5 > Maximum price, and select the option
you require from the drop down list.

3. To set a minimum size for each clip, select Pond5 > Minimum size, and select the option you
require from the drop down list.

4. To set a minimum length for each clip, select Pond5 > Minimum length, and select the option
you require from the drop down list.

5. If you have not signed in to Pond5 and want to make a purchase, click on ‘Sign in...’.
6. Enable the ‘Automatically download new purchases’ box to use your purchased items

straight away.
7. Close the menu by clicking the Close button (‘X’) at the top-right corner.

Thumbnail Size
To change the size of thumbnails in Pond5:

1. Right-click in the left half of the screen (in the Pond5 panel). The Import Commands menu opens.
2. To set the size for thumbnails in your search results, select Pond5 > Appearance > Thumb

size, and select the size you require from the drop down list.
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Importing Pond5 Clips
You can import Pond5 clips, add them to a sequence, and then publish this sequence.

1. Make sure the Edit tab is selected.
2. Click the Pond5 heading under Libraries.
3. Search for the types of clips that you want (see previous task).

4. Select the clip that you want to import.
5. Click the Import button. The clip is imported into your system.
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Adding Pond5 Tracks to a Sequence
Now that you have imported some Pond5 clips, you can add them to a sequence and then publish
this sequence.

1. Select the Edit or Browse tab.

2. Select the Pond5 clip that you want to add to your sequence.
3. Drag the clip to the timeline.
4. The clip is added to the timeline.
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Publishing a Sequence with Pond5 Clips
1. Select the Edit tab.
2. Load the sequence you want to publish.
3. Right-click the sequence in the viewer.
4. Select Publish.
5. Select one of the following options:

● Flattened media file - Select this option if all edits have been made to the sequence and
you want to save the clips within the sequence as one file.

● Sequence metadata - Select this option if you want the sequence to be available for
other users to edit before it is finished.

6. If you select Sequence metadata you have the following options:
● Tick the Upload local media files box to include clips that are on your local system.
● Tick the Upload sequence proxy to include a rendered version of the sequence that

AirFLOW can play.
● The storage space option is only available if you tick the upload local media, to indicate

where you want your local media to be uploaded to.
7. Click Publish. A warning displays. Click Yes to see a list of the files that you have not yet purchased:
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Purchasing Pond5 Tracks
1. The Purchase Media dialog box displays.

2. Click Purchase.
3. Sign in to Pond5 with your username and password.

4. Click Sign In. You are taken to the Pond5 website where you can purchase the clips.

5. Select your payment method and add your details.
6. Click Pay.
7. Once successful, the high resolution clips are downloaded from Pond5 and replace the low

resolution proxies in the timeline sequence.
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Chapter 15: System Settings
The System Settings menu allows you to customize the appearance of FLOW Story, apply system
tests, and create keyboard shortcuts and macros.

Systems Settings Menu
You can use the System Settings menu to change the appearance of FLOW Story, set the language of
screen prompts (localization) and perform hardware tests.

1. In the Projects Browser (the first screen you see when you open FLOW Story), click on the
Cogs icon at the top right corner of the screen.

2. The System Settings menu opens.
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Manage Project Spaces
Adding a Server
You can add additional servers to FLOW Story providing they are configured to run FLOW Story and
if you have a valid user account on that server.

1. Open the System Settings menu and select FLOW Servers > Manage.
2. When the Manage FLOW Servers dialog box opens, click the Add button.

3. The FLOW Server Details dialog box opens.
4. Type the IP Address of the server you want to add in to the Address field.
5. Type a name for the server in the Title field. This is the name that displays on the server tab

in the Project Browser.
6. Click Add. The server is added to the Project Browser.

Renaming a Server
Note: This procedure does not change the domain name of the server - only the name that displays
in the FLOW Story client.

If you want to change the name of a server that displays in the Project Browser:

1. Open the System Settings menu and select FLOW Servers > Manage.
2. The Manage FLOW Server dialog box opens.
3. Click on the server you want to rename.
4. Click the Add button. The Server Details dialog box opens.
5. Type the new server name in the Title field, and then click the Add button.
6. The new server name displays in the Project Browser.
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Removing a Server
To remove a server:

1. Open the System Settings menu and select FLOW Servers > Manage. The Manage FLOW
Server dialog box opens.

2. Click on the server you want to remove.
3. Click the Remove button. The Server is removed - no warning message is given that the

server is about to be removed.

Updating Mount Options for a Server
To change the mount options for an existing server:

1. Remove the server you want to update - see "Removing a Server".
2. Add the server again with the mount options you require - "Adding a Server".

Appearance
Changing the Application Appearance
You can change the appearance of FLOW Story as follows:

1. Open the System Settings menu and select User Interface > Appearance.
2. The User Interface Appearance dialog box opens.

3. To change the size of text and the UI:
a. Move the slider to the right to increase text / UI size, or to the left to decrease text / UI size.
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b. Tick the ‘Calculate automatically’ box to disable the text / UI size slider.

The Sample panel ‘A’ shows the result of your adjustments before you commit to change
your settings.

4. To change the color of UI elements such as window background, text, headings, selections,
and so on:
a. Click on the colored box to the right of the item you want to change.
b. A color palette opens.
c. Use the color picker to choose the color you require, or select by adjusting the Red,

Green, Blue (RGB) sliders.
d. Adjust the Hue, Saturation and Luminance (HSL) by typing directly into the named text

box, or adjusting the slider.
e. Click outside the color palette to return to the User Interface Appearance dialog box.

5. Move the Brightness and Contrast sliders left or right to decrease or increase the respective
brightness and contrast levels.

6. Select the font you require from the Typeface drop down list.
7. Move the slider to the right to increase font size, or to the left to decrease font size.
8. Click the Use new settings button to save your settings.
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Save Preset
You can save the appearance settings you make as presets, allowing you to switch between the
default and your personal presets.

1. Do one of the following:
● Click on the Cogs icon in the User Interface Appearance dialog box.
● Right-click inside the User Interface Appearance dialog box.

2. From the menu that opens, click on ‘Save settings as new preset’.
3. A Save Preset dialog box opens.
4. Type the name for your preset and then click Save.
5. The preset is saved and is added to the User Interface Appearance menu.

Loading a Preset or Restoring Factory Defaults
To load a preset or restore the appearance to the default settings:

1. Click on the Cogs icon in the User Interface Appearance dialog box.
2. From the menu that opens, click on the Preset you wish to use, or click on Restore Factory

Defaults to load the default FLOW Story theme.
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Localization
You can change the localization of FLOW Story text (Wording) to make it suitable for your language and location. If a localization file does not exist for
your region, you can create your own file by translating the default English template or another localization file.

Importing a Localization File
To import an existing language / localization file:

1. In the Project Browser, click on the Cogs icon and, from the menu that opens, select User
Interface > Wording.

2. When the Wording dialog box opens, click on the Cogs icon in the title bar.
3. From the menu that opens, click on Import Wordings. The Import Wordings dialog box opens.

4. Navigate to the folder where your localization files reside. Localization files have the file
extension .LwWords.

5. Select the file you want and then click Ok.
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Creating a Localization File
If a localization file for your language or region is not available, you can create your own if you have
the appropriate language translation skills.

Note: If your translation exceeds the length of the original caption text, part of your translated
caption may not display in the space provided.

Complete the following:

1. Open the System Settings menu and select User Interface > Wording.
2. The Wordings dialog box opens, displaying text for FLOW Story captions in the language of

the last localization file to be loaded. (If the localization in FLOW Story has never been
changed, this will be the default English template.)

3. Use the currently loaded localization, or load a localization that is easy for you to translate.
See "Importing a Localization File".

4. Type over each numbered caption or text line with the translation appropriate to your
language and / or region. Try to keep your translated text as short as possible in order for
your translation to display correctly in FLOW Story.

5. Any changes you make to the dialog box are applied immediately to FLOW Story. However,
we recommend that you save your work at regular intervals to a file created for your
localization project. See "Exporting a Localization File".
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Exporting a Localization File
When you have added your localization to FLOW Story, you can save it as a file for backup purposes
or distribution to other users. Do the following:

1. Click on the Cogs icon at the top right corner of the Wordings dialog box.
2. From the menu that opens, click on Export Wordings. The Export Wordings dialog box opens.

3. Type a name for your localization file and then click OK.
4. A message box displays confirming that a localization file has been created.
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Reverting to Default Localization
If you want to return to the default localization for FLOW Story, or you have made a mistake in your
localization project and want to start again, do the following:

1. Click on the Cogs icon at the top right corner of the Wordings dialog box.
2. From the menu that opens, click on Revert to default wordings. If the menu option is

disabled, you are already using the default localization - you do not have to proceed further.
3. A message box displays, warning that any changes to your current localization will be lost

unless you have already saved them in an export file.
4. Click Yes to load the default localization, or No to cancel the operation.

Using Multiple Monitors
If you have only one monitor, the full screen display uses that monitor, obscuring the user interface.
If you have dual monitors, only the extended display is used for full screen display, allowing to view
the user interface and full playback screens at the same time. It is recommended that both displays
are of the same resolution.

Note: OS X or macOS systems only: In Finder, open System Preferences > Mission Control, and untick
‘Displays have separate spaces’.

1. On the project browser screen, click the cogs menu icon on the panel that opens choose
which display you wish to display the fullscreen playback on for fullscreen preview monitor.

2. Select the monitor you want to use for full screen playback from the drop down list.

Note: If you only have a single display, the option for changing the fullscreen preview will not be available.
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Hardware Tests
Running Hardware Output Tests
You can test the hardware connected to your media outputs by generating a video test pattern and
sending various audio waveforms.

1. Open the System Settings menu and select Hardware > Output Tests.

2. The Hardware Output Tests dialog box opens and a signal sounds.
3. On each of the audio channel pairs (1/2 and 3/4) select the options you require:

● Waveform: sine or sweep
● Frequency: 100Hz, 440Hz, 900Hz, 1kHz or 10kHz
● Level: Type a level in dBFS (decibels relative to full scale) directly into the text box or

select one of the options from the drop down list.
● Pattern: Constant Tone, GLITS or SIT.
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GPU Tests
To test your system Graphical Processor Unit (GPU), do the following:

1. Open the System Settings menu and select Hardware > GPU Tests.
2. The GPU Tests message box opens.

3. FLOW Story performs a series of tests on your system and displays the results of each test in
the GPU Test message box. A progress bar at the bottom of the dialog box displays the
approximate time remaining to complete the tests.

4. A message displays when the tests have completed.
5. If any of these tests display as 0 fps then your graphics card is not suitable to run FLOW

Story, or your graphics card driver needs updating.
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Keyboard Shortcuts
You can assign keys or combinations of keys for tasks you do often in FLOW Story. If you use a
physical keyboard suited to your language or region, you can import the appropriate preferences for
that keyboard into FLOW Story. FLOW Story also has keyboard profiles for users who are more
familiar with Avid or Final Cut Pro applications that can be used instead.

Assigning a Keyboard Shortcut
To assign a key or combination of keys to a function:

1. Open the System Settings menu and select User Interface > Key Assignments.
2. The Key Assignments dialog box opens.

3. (Optional) To sort the command functions in alphabetical order, click on the Command
column header.

4. (Optional) To revert to sorting on Categories (Console Actions, Global Commands, and so on)
click on the Category column header.

5. Select the function you want to change from the main panel.

If you cannot find the function you want, type its name into the text box ‘A’ and click the
Search button.

6. Click the ‘Assign Key’ button.
7. The Choose Key dialog box opens.
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8. Press a key, or key combination, on your keyboard. If the key is unassigned, the dialog box
displays the message ‘(Unassigned)’.

9. Click on the Add Key.
10. The selected key or key combination is assigned to the function.

Importing Keyboard Shortcuts
To import keyboard shortcuts from an external file:

1. Do one of the following:
● In the Key Assignments dialog box, click on the settings menu (Cogs icon) and, from the

menu that opens, click ‘Load’.
● Right-click in the Key Assignments dialog box and, from the menu that opens, click ‘Load’.

2. The Import Preferences dialog box opens.
3. Navigate to the folder where the preferences file you want resides. FLOW Story ships with

preference files for Avid and Final Cut Pro, which can be found in the Preferences folder:

Windows 7, 8 - C:\Program Files\EditShare\Flow\Story\Preferences

Mac OS X - Located in the FLOW Story bundle: /Flow Story.app/Contents/
Resources/Preferences

4. Click OK. The keyboard shortcuts are imported into FLOW Story.
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Exporting Keyboard Shortcuts
To export keyboard shortcuts:

1. Do one of the following:
● In the Key Assignments dialog box, click on the settings menu (Cogs icon) and, from the

menu that opens, click ‘Save’.
● Right-click in the Key Assignments dialog box and, from the menu that opens, click ‘Save’.

2. Do one of the following:
● Navigate to the location you want to export the file to.
● Click Places, and then navigate to the location you want.

3. Click OK. Your keyboard shortcuts file is exported to the required location.
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Reset Keyboard Shortcuts
To reset keyboard shortcuts:

1. Do one of the following:
● In the Key Assignments dialog box, click on the settings menu (Cogs icon) and, from the

menu that opens, click ‘Reset all’.
● Right-click in the Key Assignments dialog box and, from the menu that opens, click ‘Reset all’.

2. All keyboard shortcuts are reset to the default template.
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Creating an HTML Report
You can export the current keyboard assignments to an HTML report, as follows:

1. Do one of the following:
● In the Key Assignments dialog box, click on the settings menu (Cogs icon) and, from the

menu that opens, click ‘Create HTML Report’.
● Right-click in the Key Assignments dialog box and, from the menu that opens, click

‘Create HTML Report’.

2. An HTML page listing the current key assignments opens in your web browser. The listing
does not include Macros that you have created.
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Default Keyboard Shortcuts
Console Actions

Backtime

Cue Marker

Delete

End

Forward Nudge

Forward Nudge (2)

Jog Left

Jog Right

Join

\

M

x

;

.

Right arrow

Shift+Left arrow

Shift+Right arrow

Tab

Remove

Remove Cue

Marker Replace

Reverse Nudge

Reverse Nudge (2)

Right

Start

Stop

Swap

Switch

Z

#

b

,

Left arrow

s

h

K

[

Esc

Left

Mark

a

i

Trim  In

Trim Last Out
Trim Next In

W

Q
r

Mark segment end } Trim Out e

Redo

Redo (2)

Alt+

Ctrl+Y

Undo

Undo (2) Ctrl+Z

Redo (3)
Redo (4)

Command+Y
Shift+Command+Z

Undo (3)
Unmark

Command+Z
p

Global Commands

Add tracks Backspace Simple Wipes & Dissolves F9

Audio Crossfades F10 Slide clip t

Slip clip y

Clipboard Insert Ctrl+V Swap track Alt+s

Clipboard Insert (2) Command+V Swap track (2) Alt+β

Configure current effect F6 Switch to audio view F4

Copy to clipboard Ctrl+C Switch to editing view F2

Copy to clipboard (2) Command+C Switch to logging view F1
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Copy track

Copy track (2)

Alt+k

Alt+˚

Switch to video effects view F3

Cut to clipboard Ctrl+X Toggle A1 a+ 1

Cut to clipboard (2) Command+X Toggle A1 (2) 3

Toggle A2 a+ 2

Delete selection Delete Toggle A2 (2) 4

Toggle A3 a+ 3

Empty cut c Toggle A3 (2) 5

Exit Application Alt+x Toggle A4 a+ 4

Exit Application (2) Command+X Toggle A4 (2) 6

Exit Application (3) Alt+~ Toggle A5 a+ 5

Toggle A5 (2) 7

Insert & next (preserve track sync) v Toggle A6 a+ 6

Toggle A6 (2) 8

Mark clip ] Toggle A7 a+ 7

Mark Out o Toggle A7 (2) 9

Move cut u Toggle A8 a+ 8

Move track Alt+m Toggle A8 (2) 0

Move track (2) Alt+M

Toggle Full Screen playback F12

Next Audio Node Up arrow Toggle Full Screen playback (2) F11

Next keyframe Ctrl+Up arrow Toggle play Space

Toggle status window Ctrl+B

Play faster backwards j

Play faster forwards l Toggle V1 Hold v Tap 1

Pop out original n Toggle V1 (2) 1
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Preview Alt+Space Toggle V2 Hold v Tap 2

Previous Audio Node Down arrow Toggle V2 (2) 2

Previous keyframe Ctrl+Down arrow

Project details Home Video analysis PgUp

Query Nudge Backwards - (numpad) Zoom in =

Query Nudge Forwards + (numpad) Zoom out -

Macros
If you want to group together a sequence of key functions and launch them from a single keystroke,
you can create a Macro to do this. For example, you can create a Macro to trim the In Point of a clip
to the current timeline indicator position. The macro would consist of the following steps:

● Clear all marks on the timeline (Unmark)
● Mark the current playing position (Mark)
● Go to the previous cut point (Left)
● Delete marked section and close the gap (Delete)

You then assign a keystroke or keystroke combination to start the Macro. Every time you press the
keystroke combination, the Macro initiates the functions you defined; trimming the In Point of the
current clip to the current timeline indicator position.
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Creating a Macro
To create a macro:

1. Do one of the following:
● In the Key Assignments dialog box, click on the Cogs icon and, from the menu that

opens, select Create a macro.
● Right-click in the Key Assignments dialog box and, from the menu that opens, select

Create a macro.
2. The Create A Macro dialog box opens.

3. Add a title and description.
4. Click the Add button.
5. The Add Command(s) dialog box opens:

a. Click to select the commands you want in your macro, for example, Unmark, Mark, Left
and Delete.

b. Click OK to close the Add Command(s) box. The selected commands load into the Create
a Macro dialog box.

6. Using the mouse, drag the commands into the order you require.
7. To remove a command, highlight it with the mouse and then click Remove.
8. Click the Create button. Your macro is added to the Key Assignments dialog box.
9. In the Key Assignments dialog box, click on your macro to highlight it and click the Assign Key button.
10. The Choose Key dialog box opens.
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a. Press a key, or key combination, on the keyboard, or one of the eight User keys on the
FLOW Story Console.

b. If the key is already assigned to a function, that function displays in the Choose Key dialog box.
If you do not want to keep the original key assignment, try another key combination.

c. When you have decided on your key assignment, click on Add key.
d. The selected key or key combination is assigned to the function.

Editing a Macro
To edit an existing Macro:

1. In the Key Assignments dialog box, right- click on the Macro you want to edit and, from the
menu that opens, select Edit a Macro. Alternatively, you can select Edit a Macro from the
settings menu (Cogs icon) if you have the selected Macro selected.

2. The Edit window for the selected Macro opens.
3. Make any changes you require, as described in steps 3 to 8 of "Creating a Macro".

Deleting a Macro
To delete a Macro:

1. In the Key Assignments dialog box, right- click on the Macro you want to delete and, from the
menu that opens, select Delete a Macro. Alternatively, you can select Delete a Macro from
the settings menu (Cogs icon) if you have the selected Macro selected.

2. A message box opens, asking you to confirm the deletion.
3. Click the Yes button to delete the Macro, or No to cancel.
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Chapter 16: Troubleshooting
If you are having problems with your FLOW installation, see the following topics before you contact
your local EditShare Technical Support office:

● "Network"
● "Media"

Further troubleshooting information can be found at https://airflow.cloud/story/faq.

Network
Cannot Connect to FLOW Server
If you cannot connect to the FLOW server:

1. If the IP Address text box displays in the login screen, check that the correct IP address or
server name is entered in the box.

2. Check your connection to the FLOW server. Do the following:
a. Open a command line prompt and type ping <server name> where ping <server

name> is the hostname or IP Address of the server.
b. If no packets are returned, or the message destination host unreachable displays,

check the network cable connection to the LAN port of your workstation.
c. Check that your workstation is connected to the FLOW network. Check you have a

network cable connected and that the LAN port LED is flashing.
d. Server Groups option only: Check you are connected to the correct server group at login.

3. If you use Wi-Fi for working away from your organization, or for AirFLOW, ensure that Wi-Fi is
switched OFF when you are using a cable network connection for FLOW Browse, FLOW
Logger, Automation or FLOW Control.

4. If you still have no connection, contact the administrator for your FLOW system.

Cannot Log In
Check that you are using the correct username and password. Usernames and passwords are case
sensitive. Make sure the Caps Lock key is OFF.

No Network Folders or Storage Spaces are Visible
Check the following:

● Check the server you are trying to access is online and connected to the network.
● You have to be a member of a storage space in order to view or use it. See "One or More

Storage Spaces are not Visible".
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Unable to Scan Storage Folders with Special Characters in
Folder Name
For SMB and EditShare storage, due to an existing gap in filename conventions between OS types,
using special characters might cause unexpected or inconsistencies between Flow Clients or
Services. Therefore EditShare recommends avoiding the use of the following characters in folder
names/filenames.

If either SMB server or client is running on Windows, avoid:

● < (less than)
● > (greater than)
● : (colon)
● " (double quote)
● / (forward slash)
● \ (backslash)
● | (vertical bar or pipe)
● ? (question mark)
● * (asterisk)
● filename/foldername ended or started with space characters

If either SMB server or client is running on MAC OSX, avoid:

● : (colon)
● / (backslash)
● filename/foldername started with . (dot)

If either SMB server or client is running on Linux, avoid:

/ (slash)

For other storage types, it is okay to use special characters, with the exception of the "backslash (/)",
as long as those characters are allowed by the Storage Vendor.

One or More Storage Spaces are not Visible
You cannot access a Storage Space if you have not been designated a member of it. If you think you
should be a member of a particular Storage Space, ask the administrator for your FLOW system.

New Files are not Visible
FLOW will not display new files in a storage space until a record of the file has been added to the
FLOW database. Files created by FLOW applications are added to the database automatically but
other files, for example files that have been uploaded to a storage space, will not display until a scan
has been performed. To see new files in FLOW, do one of the following:
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● Open FLOW Control or FLOW Story and perform a scan of the storage space or individual file
(see “Scanning Storage Spaces”). You require user privileges to scan items in FLOW.

● Ask the Administrator for your FLOW system to start a manual scan of the storage space.
● Wait for a scheduled scan of the storage space. Your FLOW Administrator can tell you when

automated scans are scheduled.

Media
Cannot Access or Play Clips
Check the following:

● There is a proxy available for the clip you want to play.
● If there is not a proxy for the clip you want to play, the drive containing the source material

may not be mounted in FLOW. Contact the administrator for your FLOW system.
● There may be a problem with the disk drives on the server you are trying to access. Contact

the administrator for your FLOW system.

Clips will not Play
Check the following:

● FLOW supports a large range of video and image formats. To check that your video formats
are supported by FLOW, see the FLOW Supported Formats Guide.

● It is important to keep your FLOW software up to date in order to take advantage of the
latest codecs and drivers that are available.
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Clips Appear to be Out of Date
If the clips in FLOW Story appear to be out of date (for example, modifications have been made to
them that are visible in AirFLOW but not in Story), hold the Shift key, which will force Story to treat
the server versions as new/updated and resync accordingly. Syncing only occurs when the server
contents are marked as having been modified.

Audio not Present
Check the following:

● Confirm audio is present on the source material.
● Check audio connections on the FLOW Story client system.
● The audio tracks in the timeline are not disabled.

Media is Offline

If media clips display as Offline, check the following:

● If the FLOW server is offline.
● If the file is a local file and it has been moved from its original location.
● Open the Media tab in your Project Card and check if the Import Destination has been changed.

Access
Cannot Start FLOW Story
Ask the Administrator for your FLOW system to confirm that you have a valid FLOW user account
and that account allows you to run FLOW Story.

If you have a valid user account and the FLOW server is unavailable you can usually run FLOW Story
in offline mode. However, Storage Spaces will be unavailable to you.

Cannot Create Projects
Ask the Administrator for your FLOW system to confirm whether you are allowed to create FLOW
projects or not.
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FLOW - Transfer Service Partial File Copy
The partial file copy runs as a task within FLOW Story. On failure a pop-up appears containing error
messages. For more detail, view the flow-transfer.log located on the FLOW server at:

/var/log/flow/flow-transfer.log

For mountable spaces, partial restore is achieved using the FLOW transcode capability. Check
/var/log/flow/flow-ingest.log for more detail on issues relating to later phases of the operation.
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Appendix A: Administrator’s Guide
The procedures listed in this Appendix should only be carried out by Administrators authorized to
manage the FLOW system.

Communication between FLOW Story client workstations and is made via the EditShare Gateway,
which should run on a dedicated server. Your EditShare representative or reseller will have supplied
a unit for this purpose.

FLOW Story Configuration Summary
The setting up of FLOW Story on an EditShare FLOW system is as follows:

1. Make sure the server designated as the EditShare Gateway is connected to the FLOW
network and is configured correctly.

2. Start FLOW Control and assign users to FLOW Story. See "Controlling User Access".
3. Open FLOW Control and make sure users have the correct permission for the storage spaces.
4. Install FLOW Story on users’ workstations.

Controlling User Access
Access to FLOW Story’s features are granted on a User by User basis in FLOW Control.

Administrators should consider whether users’ access to AirFLOW is required at the same time as
granting access to FLOW Story.

See the FLOW Administrator’s Guide, Chapter 2, for instructions on how to set user access to FLOW
Story using FLOW Control.

247



248


